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A. INTRODUCTION 

This Data Acquisition and Processing Report outlines the acquisition and processing 
procedures used for the Hydrographic survey of Central Puget Sound (OPR-N395-FA-13) by 
NOAA Ship Fairweather.  
 
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, 
the acquisition and processing procedures used and deliverables produced are in accordance 
with the NOAA Hydrographic Survey Specifications and Deliverables Manual (HSSD) April 
2013, the Field Procedures Manual (FPM), April 2013, and all active Hydrographic Surveys 
Technical Directives (HTD). 
 
Any additions and changes to the following will be included with the individual Descriptive 
Reports or by submission of an addendum. 
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B. EQUIPMENT 

Detailed descriptions of the equipment and systems, including hardware and software, used for 
bathymetric data acquisition and processing are listed below. 
 

1.0 Hardware 

 
1.1 Hardware Systems Inventory 

Detailed hardware information, including models and serial numbers, is included in Appendix I 
of this report.  All launch hardware was installed during April 2013.  Manufacturer’s product 
specifications are maintained with reference documentation on board Fairweather. 
 
1.2 Echo Sounding Equipment 

1.2.1 Reson 7111 Multibeam Echosounder (MBES) 

Fairweather is equipped with a Reson 7111 MBES.  The system was upgraded from a Reson 
8111 in October 2009, which involved replacing the dry end transceiver and processor units 
but leaving the wet end hull-mounted projector and receiver intact.  The Reson 7111 is a 100 
kHz multibeam system with swath coverage of 150°.  The swath is made up of 301 discrete 
equidistant beams with an along-track and across-track beamwidth of 0.5°.  It has a specified 
depth range of 3 to 1200 meters, though the typical operational depth range of the Reson 7111 
on Fairweather is 20 to 300 meters.  No calibration information was provided by the 
manufacturer for the system.  However, since there are a limited number of systems in the 
world used for hydrography, we have worked with RESON and INFREMER regarding 
improvement with the sonar bottom detection algorithms.  Engineering quality receiver and 
transceiver boards were replaced in 2012 with new production level boards.  
 
The Reson 7111 is hull-mounted within a reinforced projection that extends 27 inches below 
the keel.  It is located 39.5” starboard of the centerline at approximately frame 29 (see Figure 1 
& Figure 2). 
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Figure 1: RESON SeaBat 7111 MBES 

 
Figure 2: 7111 Installed on Fairweather
 

.  
 
Unusually high uncertainty values are often experienced in the outer 6 degrees of Reson 7111 
data on either side of the swath.  To avoid exceeding IHO Order 1 specifications for depths 
shoaler than 100 meters, these outer beams were rejected in post processing for surveys with 
data collected in this depth range.  Multibeam line spacing is tightened in these areas during 
acquisition to prevent the creation of holidays in the data. 
Use of the RESON 7111 was limited to mid-season due to a failure of the systems receiver 
assembly.  No data was collected following this failure and the system is currently scheduled to 
be replaced. 
 
1.2.2 Reson 7125 SV Multibeam Echosounder (MBES) 

Survey launches 2805, 2806, 2807, and 2808 are each equipped with a dual frequency Reson 
7125 SV MBES.  The Reson 7125 SV has both a low frequency (200kHz) and high frequency 
(400kHz) transmit array with a swath coverage of 128°.  The swath is made up of 256 discrete 
beams for 200 kHz and both 256 or 512 discrete beams for 400 kHz.  The typical operational 
depth ranges for the Reson 7125 SV operating at 200kHz is 3 to 400 meters and 3 to 100 
meters operating with the 400kHz system.  Each system is hull mounted along the centerline 
and includes a single topside unit (see Figure 3 & Figure 4.  No calibration information was 
provided by the manufacturer for the systems; however, the unit installed on 2805 was tank 
calibrated for backscatter at the University of New Hampshire (UNH) during the winter of 
2011.  Preliminary calibration reports are forthcoming.  Research is ongoing for 7125 SV 
backscatter calibration.   
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   Figure 3: Reson 7125 SV topside processor      Figure 4: Reson 7125 SV transducer arrays 
 
1.2.3 Reson 8125 Multibeam Echosounder (MBES) 

Fairweather is equipped with a Reson SeaBat 8125 MBES with snippet option.  The Reson 
8125 is a 455 kHz multibeam system with swath coverage of 120°.  The swath is made up of 
240 discrete beams with an along-track beamwidth of 1° and an across-track beam spacing of 
0.5°.  It has a maximum range scale of 120 meters for surveying depths less than 60 meters 
with a complete swath.  The typical operational depth range of the Reson 8125 is 3 to 50 
meters.  No calibration information was provided by the manufacturer for the system. 
 
The system can be attached to any of the launches using a bolt-on variable angle adjustable 
sled mount which can be on either side of the keel and approximately centered fore and aft (see 
Figure 5).  The configuration can be mounted from 0 – 33 degrees off center.  The tilt mount 
system is utilized to assist with ensonifying vertical surfaces or inshore features for safer near-
shore MBES collection.   
 

 
Figure 5 : Reson 8125 Tilted Head Mounted on Launch 2808 
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This sonar was installed for a brief period of time during LA / Long Beach surveys H12617 
and H12618.  During that time, suitable patch values were unable to be determined after 
several attempted patch tests.  The values from the previous installation of the same mount 
provided the best quality data and were deemed sufficient by Fairweather personnel for the 
limited 8125 data submitted with survey H12618.  Reson 8125 MBES data for H12617 was not 
deemed useful as it only contributed with the ensonification of kelp on the breakwaters and the 
seafloor under piers within the harbor.  The RAW data was submitted for archival to NGDC, 
however, the processed depths were not retained.  
 
1.3 Positioning, Heading, and Attitude Equipment 

1.3.1 Applanix Positioning and Orientation System for Marine Vehicles (POS MV) 

Fairweather and her launches are each equipped with a POS MV 320 V4, configured with 
TrueHeave™.  The POS MV calculates position, heading, attitude, and vertical displacement 
(heave) of a vessel.  It consists of a rack mounted POS Computer System (PCS), a strap down 
IMU-200 Inertial Measurement Unit (IMU), and two GNSS antennas corresponding to GNSS 
receivers in the PCS.  Launches 2805, 2806, 2807, and 2808 are equipped with Zephyr II 
GNSS antennas with BD960 (Launch 2805) and BD950 (Launch 2808) PCS receiver cards.  
Both launch PCS units for 2805, 2806, 2807, and 2808 have internal logging capabilities to 
eliminate packet drops across the acquisition network.  The port side antenna is designated as 
the primary receiver, and the starboard side antenna is the secondary receiver for all vessels 
(see Figure 6).  The POS MV firmware versions and the controller software versions that are 
currently installed are listed in the Hardware Inventory in Appendix I.  
 
For all multibeam systems aboard Fairweather’s launches, timing between the sonar swath, 
position, heading and attitude information was synchronized by utilizing the proprietary UTC 
string from POS MV.  A timing string is sent from the POS MV to the Reson topside unit via 
serial connection and to the Hypack acquisition computer via Ethernet.   
 
For the launch PCS units with internal logging capabilities, data is logged as small 12 MB files 
which can be concatenated into a single .000 file. When files are concatenated, it occurs 
through the NOAA in-house tool “POSConcatenator” created by Grant Froelich of the Pacific 
Hydrographic Branch. 
 
POS MV controller software was used to monitor position accuracy and quality during data 
acquisition.  This ensured that positioning accuracy requirements are met, as outlined in section 
3 of the HSSD.  The POS MV controller software provides clear visual indications whenever 
accuracy thresholds are exceeded.  
 
1.3.2 POS MV GAMS Calibration 

In the spring of 2013, GNSS Azimuth Measurement System (GAMS) calibrations were 
performed on each of Fairweather’s POS MV units mounted to launches 2805.  The GAMS 
calibration procedure was conducted in accordance with instructions in chapter 4 of the POS 
MV V4 User Guide, 2009.  Results and calibration reports are maintained with reference 
documentation aboard Fairweather.  Actual calibration dates are listed in the Hardware 
Inventory included in Appendix I. 



 

 - B-5 -  

2013 DAPR NOAA Ship Fairweather 

 

 
Figure 6: POS GNSS Antennas 

 
1.3.3 DGPS Receivers 

Launches 2805, 2806, 2807, and 2808 are equipped with Hemisphere GPS MBX-4 DGPS 
receivers to correct the POS MV GPS positions used during real-time MBES and SSS data 
acquisition.  The DGPS receivers are configured in manual mode to allow reception of only 
one U.S. Coast Guard (USCG) differential GPS beacon station at a time.   
 
Differential GPS (DGPS) is the primary method of real-time positioning.  The individual 
descriptive reports for each survey list the U.S. Coast Guard beacon sites and frequencies used 
for differential corrections utilized during hydrographic surveying. 
 
All individual vessel POSMV files from all platforms are post processed unless otherwise 
noted in respective survey Descriptive Reports and project Horizontal and Vertical Control 
Reports.   
 
 
1.4 Sound Speed Equipment 

1.4.1 Sound Speed Profiles 

1.4.1.1 SBE 19plus SEACAT Profiler 

Fairweather is equipped with two SBE 19plus and two SBE 19plusV2 SEACAT sound speed 
profilers used to acquire conductivity, temperature, and depth (CTD) data in the water column 
to determine the speed of sound through water.  One of the SBE 19plus profilers has pressure 
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sensors rated to 1000 meters.  The second SBE 19plus profiler has a pressure sensor rated to 
3,500 meters.  The two SBE 19plusV2 profilers have pressure sensors and units rated to 600 
meters. 
 
The SBE 19plusV2 SEACAT sound speed profilers were calibrated by the manufacturer during 
the 2012-2013 winter repair period.  The current calibration files can be found in Appendix I. 
 
Periodic quality assurance checks include comparison casts between CTD instruments.  Data 
quality assurance (DQA) checks are conducted during each survey leg include comparison 
casts between two instruments as per section 1.5.2.2.2 of the FPM for each survey.  Records of 
the DQA tests performed are kept aboard the ship and are included with the digital Separates II 
– Sound Speed Data for each survey.  To ensure that the CTDs continue to function properly a 
stringent maintenance schedule is followed using guidelines from the manufacturer's 
recommendations.     
 
 
1.4.2 Surface Sound Speed   

1.4.2.1 Reson Sound Velocity Probe (SVP 71)   

Survey launches 2805, 2806, 2807, and 2808 are each equipped with a Reson SVP 71.  The 
SVP 71 measures the speed of sound near the transducer to provide real time surface sound 
speed values to the Reson 7125’s processing unit.  The 7125 SV requires surface sound speed 
information for beam forming due to the flat faced transducer.  The units are hull-mounted 
adjacent to the Reson 7125’s transducers as shown in Figure 7.   
 
All of the sensors were initially calibrated by the manufacturer and current calibration files 
were supplied with the units upon receipt in 2010.  The delivery calibration files can be found 
in Appendix I. Daily quality assurance checks are completed with the annually calibrated 
Seabird 19+ CTD’s. 
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Figure 7: SVP 71 sound speed unit (right) and a Reson 7125 

 
1.4.2.2 Reson Sound Velocity Probe (SVP 70)   

 
1.4.2.3 Odom Digibar Pro   

Fairweather is equipped with one Odom Digibar Pro.  The Digibar measures the speed of 
sound near the Reson 8125 and is attached to the same sled mount to provide real-time surface 
sound speed values.  The unit is mounted horizontally to starboard and above to the aft of the 
Reson 8125 on the sled as shown below.   
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Figure 8 : Odom Digibar and Reson 8125 Tilted Head on Launch 2808 

 
 

2.0 Software 

2.1 Software Systems Inventory 

An extensive software inventory with documentation of the software systems used by 
Fairweather is maintained as a survey Software Inventory spreadsheet on board Fairweather.  
This spreadsheet includes specifics such as software applications, versions, and hotfixes that 
are loaded on specific survey processing computers.  Snapshot .pdf files are produced 
approximately bi-monthly or whenever a major software update occurs.  The snapshot 
inventories are included within Appendix I of the DAPR.   
 
2.2 Data Acquisition Software  

2.2.1 Hypack® Hysweep 

Fairweather uses the Hypack® Hysweep acquisition software package to log all Reson MBES 
data.  Hysweep displays real-time MBES coverage geo-referenced against supporting 
background files such as charts and vector shoreline files for launch coxswain to follow to 
acquire adequate MBES coverage.  The Hypack Devices (Hysweep Interface and Applanix 
POS MV Network) and Hysweep Hardware (Hypack Navigation, Applanix POS MV Network, 
and Reson) *.ini files are created with the support of HSTP field support liaison and are in 
accordance with HSTP’s configuration management documentation.   
 
Three types of files are recorded per logged line of Reson MBES data: .raw, .hsx, and .7k.  The 
.raw file contains the raw navigation files recorded directly from the POS MV (as device 0) 
and from Hysweep (as device 1).  The .hsx files contain data from Hypack  Navigation (as 
device 0), POS MV (as device 1), and the Reson MBES (as device 2).  The .7k file contains all 
raw data that Hysweep can read from the Reson, including the Reson 7008 snippets message.   
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The .hsx and .raw files are converted into HDCS data in CARIS HIPS by Fairweather 
personnel.  The .7k file is not post-processed by Fairweather personnel but is recorded for and 
submitted with the other raw data for outside backscatter research, processing and product 
development.  All three raw files are submitted directly to NGDC for archival.   
 

2.2.2 Applanix POSView 

Applanix POSView is the controller software for the POS MV.  POSView is used to configure 
the serial and network input and output ports on the POS MV PCS.  POSView is also used to 
monitor real-time position, attitude data, and their associated accuracies and to log POSPac 
.000 files.  The POSPac .000 file contains the TrueHeave information that is applied to the 
MBES HDCS data in CARIS HIPS immediately after conversion.  The POSPac .000 file is 
also post-processed into a PPK SBET file using Applanix’s POSPac processing software.  
  
 
2.3 Data Processing Software 

2.3.1 CARIS 

CARIS HIPS™ (Hydrographic Information Processing System) is used to process all 
multibeam data including data conversion, filtering, sound speed corrections, tide correction, 
merging and cleaning.  CARIS HIPS also calculates the Total Propagated Uncertainty (TPU) 
used to produce Bathymetry Associated with Statistical Error (BASE) surfaces which assist the 
Hydrographer in data cleaning and analysis, and to produce BASE surfaces.   
 
CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery 
data including data conversion, altitude adjustment, slant-range correction, and beam pattern 
correction.  CARIS SIPS is also used to inspect the imagery for contacts and to produce side-
scan imagery mosaics. 
 
CARIS Notebook™ and CARIS Bathy DataBASE™ BASE Editor (BDB) are used to compile, 
display, and edit source shoreline, shoreline updates and S-57 features that are collected 
directly in the field.  The .hob files created in Notebook and BDB are exported to S-57 file 
format as the current shoreline deliverables.    
 
CARIS Bathy DataBASE™ BASE Editor is also used for data quality assurance checks on the 
BASE surface and for surface differencing.  
 
CARIS Plot Composer is used to create final field plots and special constituent products.   
 
2.3.2 Fledermaus™ and FMGT 

Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data 
visualizations and creation of data quality control products, public relations material and 
reference surface comparisons.  Fairweather personnel process one line of multibeam 
backscatter per sonar, per day to check Reson Snippet backscatter data in following with the 
best practices established by NOAA personnel to date.  If warranted, specifics of its use or 
findings for a given survey will be documented in the individual descriptive report.   
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2.3.3 Applanix POSPac MMS and POSGNSS 

Applanix POSPac MMS and POSGNSS are used to post process POS MV data files logged 
during MBES acquisition.  The Single Base PPK processing method is typically used when a 
single Fairweather or third party GPS base station is operating within approximately 20 
kilometers of MBES acquisition.  The SmartBase™ PPK processing method is used when a 
stable network of approximately 5-10 available third party GPS base stations such as those in 
the Continuously Operating Reference Station (CORS) system or Plate Boundary Observatory 
(PBO) suite of stations exists within approximately 200 kilometers of MBES acquisition.  On 
occasion Precise Point Positioning (PPP) is used when sufficient base stations are not available 
for Single Base or SmartBase™ PPK.  In general, Fairweather processing procedures follow 
the methods outlined in the POSPac MMS GNSS-Intertial Tools User Guide for each method.  
Processing methods specific to each project are documented in the Project Horizontal and 
Vertical Control Report.  Processing methods specific to each survey are documented in the 
Descriptive Report   
 
2.3.4 Velocipy 

Velocipy is a NOAA in-house software supported by the Hydrographic Systems and 
Technology Program (HSTP) that is used to process raw sound velocity cast files taken with 
the SEACAT CTDs on the launches and the MVP from the ship.  Velocipy creates CARIS 
format .SVP files that are applied during post processing in HIPS to MBES HDCS data to 
correct for sound speed.  The individual CTD and MVP files are concatenated into a single 
vessel file by survey.  Each vessel file contains the survey registry number and the time and 
location of each sound speed profile measured.   
 
2.3.5 Pydro 

Pydro, another NOAA program produced and maintained by HSTP, is used to produce Final 
Water Level Requests along with DTON Reports and Survey Feature Reports. The xml 
Descriptive Report (DR) is produced using the xmlDR component of Pydro, the DR pdf file is 
then produced via a stylesheet.  In addition, Pydro is used for Tidal Constituent and Residual 
Interpolation (TCARI) tide application in conjunction with CARIS HIPS and various other 
macros.   
 
Pydro is utilized to assist with sidescan and multibeam contact correlation.  Information about 
each contact is easily entered, images can be added and a final feature report can be produced. 
 

3.0 Vessels  

3.1 Vessel Inventory 

Fairweather’s survey launches 2805, 2806, 2807, and 2808 are equipped to acquire multibeam 
echosounder (MBES) and sound speed profile (.svp) data.  See Appendix I for the complete 
vessel inventory. 
 

4.0 Data Acquisition 

4.1 Horizontal Control 
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A complete description of horizontal control will be included in the project’s Horizontal and 
Vertical Control Report (HVCR), submitted for each project under separate cover when 
necessary as outlined in section 8.1.5.2 of the HSSD and section 5.2.3.2.3 of the FPM. 
 
The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless 
otherwise noted in the individual descriptive reports.   
 
Multibeam and shoreline data are differentially corrected in real time using correctors provided 
by Coast Guard beacons.  The specific beacons used for a given survey will be included in the 
Horizontal Control section of the survey’s descriptive report.  If loss of the differential beacon 
resulted in any data being recorded with C/A GPS positions it will be noted in the Descriptive 
Report for the specific survey.   
 
When possible, real time DGPS positioning may later be replaced with a post processed 
kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is usually 
dependent on a local base station supported by the ship and processed in Applanix POSPac 
MMS software using Single Base mode.  However, in areas with an adequate network of 
Continuously Operating Reference Stations (CORS) or public third-party base stations, 
Applanix POSPac SmartBase™ mode may be used.  With either Single Base or SmartBase 
processing, the resulting navigation from PPK is an improvement over C/A and DGPS 
navigation. The details of PPK use and application for a given survey will be included in the 
Horizontal Control section of the project’s HVCR or the survey’s descriptive report.   
 
4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 

Acquisition methods and platforms used are determined based on consideration of sonar 
system specifications, seafloor topography, water depth, and the capability of the acquisition 
platforms.   
 
All multibeam data are acquired in Hypack’s Hysweep® SURVEY extension (.hsx) format and 
monitored in real-time using the 2-D and 3-D data display windows and the on-screen displays 
for the Reson 7125 SV.  Adjustable parameters that are used to control the Reson include range 
scale, power, gain, pulse width, absorption, and spreading.  These parameters are adjusted as 
necessary to acquire the highest quality of bathymetry and backscatter.  Vessel speed is 
predominantly between 6-8 knots for acquisition with launch 7125 SV systems.  Speeds are 
reduced as needed to eliminate noise from the data and to ensure the required along-track 
coverage for object detection in accordance with the HSSD.   
Survey personnel follow standard operating procedures documented aboard Fairweather while 
setting and utilizing the Reson systems and Hypack for data acquisition.  The sensor offsets 
and mounting biases are entered into the Hysweep® Hardware Reson device.  This information 
is recorded in the Hypack hsx file header for corrected backscatter mosaics created with 
Hypack Geocoder.  These offsets do not have any effect on CARIS HIPS HDCS sounding 
corrections.    
 
Navigation and motion data are acquired and monitored in POSView and logged into a POS 
MV file with a .000 extension.  Various position and heading accuracies, as well as satellite 
constellations, are monitored real-time both in POSView and Hypack Hysweep®. 
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Main scheme MBES acquisition lines using the Reson 7125 SV are generally run parallel to 
the contours with appropriate overlap to ensure data density requirements for finalized BASE 
surface resolutions are met.  For discrete item developments, 200 percent coverage is acquired 
to ensure least-depth determination by multibeam near-nadir beams.  Hypack Hysweep® real-
time coverage display is used in lieu of pre-planned line files.  Hysweep® displays the 
acquired multibeam swath during acquisition and is monitored to ensure overlap and full 
bottom coverage.  If coverage is not adequate, additional lines are run while still in the area.  
 
For areas where shoreline verification is not conducted before multibeam, extra caution is 
taken by “half stepping” shoreward when operating near shore.  Half stepping is done by 
driving along the edge of real time coverage to prevent the survey vessel from ever being in 
un-surveyed waters.  Survey launch crews in the field survey to the Navigable Area Limit Line 
(NALL) line as defined by section 1.1.2 of the HSSD. 
 
4.3 Shoreline/Feature Verification 

The composite source file (CSF) in S-57/.000 format provided with the Project Instructions is 
the primary source for shoreline features to be verified.  The original project file is imported 
into CARIS BASE Editor, converted to a .hob file, clipped to the sheet limits for the specific 
survey, and named H#####_Original_Composite_Source.hob to be included with the 
deliverables.  This file is then copied and named H#####_Feature_File.hob to be utilized 
during field verification.  Additionally, AWOIS items and other features to be investigated are 
provided to the field in the project reference file (PRF).  All hob files are re-exported to S-
57/.000 format for data submission. 
 
Fairweather personnel conduct limited shoreline verification and reconnaissance at times near 
predicted negative tides within the survey limits when possible, as directed by section 3.5.5.3 
of the FPM.  Detached positions (DPs) are acquired and edits to the daily field feature files are 
recorded in CARIS Notebook and on paper DP forms and boat sheets.   
 
An inshore limit buffer line, offset 0.8 mm from the Mean High Water (MHW) line at the scale 
of the largest chart in the area, is provided with the Project Instructions.  This inshore limit 
buffer line is used in the shoreline acquisition software and on the boat sheet as a reference, 
and utilized as described in section 1.1.2 of the HSSD.  The NALL is determined in the field as 
the farthest off-shore of one of the following; the MHW inshore limit buffer specified above, 
the 4-meter depth contour, or the inshore limit of safe navigation as defined by the HSSD.  All 
shoreline features from the CSF seaward of the NALL are verified (including an update to 
depth and/or position as necessary) or disproved during operations.  Features off-shore of the 
NALL and not addressed or features of an ambiguous nature include remarks for further 
clarification.  Specifically assigned features may be investigated that are inshore of the NALL 
in accordance with the associated instruction for a given project area.  
 
Detached positions (DPs) acquired during shoreline verification indicate new features, 
revisions to source features, or source features not found in the field.  They are recorded in the 
shoreline acquisition software and on DP forms.  
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4.4 Bottom Samples 

Bottom samples are acquired according to section 7.1 of the HSSD, any deviations from this 
protocol will be outlined in the individual Descriptive Report for the survey.  Samples are 
acquired using CARIS Notebook, Hypack target files (.tgt), or by logging the latitude, 
longitude, and bottom characteristics manually.  All samples are processed similarly to other 
shoreline features as outlined below in section C - 2.2 of this report.  Bottom sample results are 
included in the Notebook .hob deliverable layer, HXXXXX_Final_Feature_File and are 
descriptively attributed as New. 
 
4.5 Sound Speed 

Sound speed casts are taken at least once every 1–4 hours during multibeam survey operations 
in accordance with section 3.5.1 of the FPM.  Fairweather’s launches collect sound speed casts 
approximately every 2 hrs utilizing the SBE 19plus and 19plus V2 SEACAT sound speed 
profilers.  These casts are then compared once daily to the SVP 71 surface sound speed (SSP) 
sensors to verify their accuracy in lieu of annual SVP 71 calibration.  The results of the daily 
SSP sensor comparisons are logged in the excel acquisition log to track instrument health.  
Deviations from this procedure will be outlined in the individual Descriptive Report for the 
survey.  
 

C. QUALITY CONTROL 

Fairweather has numerous standard operating procedures (SOPs) that are followed by 
personnel throughout the survey to ensure consistent high quality data and products. 
 

1.0 Uncertainty Modeling 

Uncertainty values for the multibeam and positioning systems on Fairweather and her survey 
launches were compiled from manufacturer specification sheets for each sensor (Heave, Pitch, 
Roll, Position, and Heading) and from values set forth in section 4.2.3.8 and Appendix 4 – 
CARIS HVF Uncertainty Values of the 2013 FPM. 
 
The manufacturer specification for POSMV heading accuracy is contingent on a 2 meter 
baseline between primary and secondary GPS antennas.  While the Fairweather has a 2 meter 
baseline her launches have on average a 1.4 meter baseline which has been seen to increase 
accuracy estimates in the field.  Based on observations in the field, the heading error value for 
all launches has been increased from the manufacturer specification and FPM guidance to 0.04 
degrees. 
 
Estimates for the Motion Reference Unit (MRU) alignment errors are taken from the standard 
deviation of the values determined by multiple personnel processing the patch test data (see 
section D 4.0).  In some instances, outlier patch test values are excluded to allow more 
reasonable MRU uncertainty values.                                                                          
 
The Fairweather TPU Values spreadsheet located in Appendix III, lists the final uncertainty 
values for Fairweather and her launches, including the default tides and sound velocity values.  
Uncertainty values relating to vessels and survey systems are entered into the HIPS Vessel File 
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(HVF) for each platform.  The tidal errors for the gauge and for zoning are determined on a 
project by project basis. Sound speed uncertainties for a given survey are based upon either the 
defaults listed in the TPU value spreadsheet or based on utilization of NOAA sound speed 
uncertainty estimation software.  Survey specific uncertainty values for tides and sound speed 
that are entered during the Compute TPU step in CARIS HIPS and how they were determined 
will be included in the individual Descriptive Report.  After SBET application, TPU values are 
recalculated using the Error Data option for Uncertainty Source in the CARIS Compute TPU 
window.  This loads more precise residual mean square (RMS) values to selected HDCS lines 
for position, roll, pitch and gyro. 
 

2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 

Bathymetry is processed following section 4.2 of the FPM unless otherwise noted.   
 
Raw multibeam data is recorded as .HSX files in Hypack, and then converted to CARIS HIPS 
HDCS format using established and internally documented settings.  After TrueHeave™, 
sound speed, and water level correctors are applied to all lines, the lines are merged.  Once 
lines are merged, Total Propagated Uncertainty (TPU) is computed.   
 
Bathymetric surfaces are created and analyzed using the resolution, depth range, and CUBE 
parameters outlined in 5.2.2.2 of the HSSD.  If these depth range values for specific resolutions 
require adjustment for analysis and submission of individual surveys then a waiver from HSD 
Operations is required and would be requested.  A detailed listing of the resolutions and the 
actual depth ranges used during the processing of each survey, along with the corresponding 
fieldsheet(s), will be provided in the Descriptive Report of each survey.   
 
BASE surfaces are created using the Density & Locale function of the CUBE algorithm and 
parameters contained in the NOAA CUBEParams_NOAA.xml.  The 
CUBEParams_NOAA.xml will be included with the HIPS Vessel Files with the individual 
survey data.  The NOAA parameter configurations for resolutions 1-32 meters are used.   
 
Multibeam data are reviewed and edited in HIPS subset mode and in swath editor as necessary.  
The finalized BASE surfaces and CUBE hypotheses are used for directed data editing at the 
appropriate depth range in subset editor.  The surfaces and subset editor view are also used to 
demonstrate coverage and to check for errors due to tides, sound speed, attitude and timing. 
 
Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and 
attitude editor if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in 
heading, attitude, or navigation data are manually rejected or interpolated for small periods of 
time.  Any editing of this nature will be outlined in the Descriptive Report for the particular 
survey. 
 
The Surface Filtering functionality in HIPS may be used in the processing of survey data to 
reject errant soundings.  If utilized, the individual Descriptive Report shall list the confidence 
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level settings for standard deviation used and discuss the particular way the surface filter was 
applied.  
 
In depths less than 20 meters and deeper and in areas of navigational significance where the 
BASE surface does not depict the desired depth for the given area, a designated sounding is 
selected.  Designated soundings are selected as outlined in section 5.2.1.2 of the HSSD. 
 
Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to 
see where and if the surfaces meet IHO Order.  The process is easily performed in HIPS and 
allows the Hydrographer to identify areas of high uncertainty with respect to depth.  This is a 
spatial quality control check rather than just a statistical list of nodes and allows for specific 
areas with problems to be isolated and addressed.  The following logic equation is used to 
create “IHO_1” child layers in the 1 through 8 meter finalized surfaces:  
 
IHO-1:  -Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5), 
 
and an “IHO_2” child layer is created in the 8, 16 meter, and greater finalized surfaces using 
 
IHO-2:  -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5). 
 
It should be noted that both IHO order 1 (~80 to 100) and order 2 (100 to 176) child layers are 
created for the 8 meter surface since it overlaps the order 1 and order 2 boundary (order1<100 
meters, order 2>100 meters). IHO surfaces are used during processing to indicate potential 
problem areas requiring attention or documentation.  Observed grid node uncertainty values are 
compared to IHO order 1 and Order 2 uncertainty standards.  The percentage of nodes meeting 
or exceeding these standards is calculated for each HIPS CUBE surface with a NOAA-
supported and distributed script, and then reported in the Descriptive Report. For surveyed 
areas that do not meet IHO standards, images of affected areas may be included. 
 
The individual finalized or combined surface’s IHO layers are exported from CARIS as a text 
file and examined to allow the Hydrographer to see the full data distribution rather than just the 
minimum and maximum values in the surface.  These data distribution are used to assess the 
quality of the survey, to ensure ninety-five percent of the data meets the appropriate IHO order 
as specified in section 5.1.3 of the HSSD.   
 
Additionally, a combined surface is reviewed in 3-D mode using one of the following 
programs, CARIS HIPS, CARIS Base Editor, or IVS Fledermaus, to ensure that the data are 
sufficiently cleaned for submission. 
 
 
 
2.2 Shoreline/Feature Data Processing 

During shoreline verification, field detached positions (DP) are acquired with CARIS 
Notebook or Hypack .tgt files.  Tide application for features requiring tide correction is applied 
in CARIS Notebook when using discrete zoning. 
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New features and any updates to the composite source shoreline, such as ledges or reefs, are 
acquired or digitized with S-57 attribution and compiled from the field daily files into the 
H#####_Final_Feature_File.hob.  Updates to source shoreline features primarily include a 
change in depth/height, position, or S-57 classification.  If the position of a feature changes, 
current guidelines are to delete current feature and create a new feature in the new location.  
Any changes to depth/height or S-57 classification are done so as an update to the S-57 object 
with the inclusion of NOAA’s object attributes.   
 
The SORIND and SORDAT S-57 attribute fields for new features or modified source features 
are updated to reflect the information for the associated survey number and date 
(US,US,graph,H#####).  All new or modified features are S-57 attributed as applicable and 
descriptively attributed as New or Update respectively.  All unmodified source features retain 
their original SORIND and SORDAT values.  Assigned features that are addressed but not 
updated are descriptively attributed as Retain and unaddressed assigned features are attributed 
as Not Addressed. 
 
Short descriptive comments taken from the boat sheets or DP forms along with investigation or 
survey methods are listed under the Remarks field.  For significant features that deserve 
additional discussion, the Hydrographer may include a recommendation to the cartographer in 
the Recommendations field, along with the Hydrographer notes and investigation methods 
provided in the Remarks field.  
 
Features that are disproved or that do not adequately portray the shoreline are descriptively 
attributed as Delete in the H#####_Final_Feature_File.hob layer.  Features with the attribution 
of Delete retain their original SORIND and SORDAT values and include a recommendation 
from the Hydrographer along with an informative remark.  
 
AWOIS investigation items are received in the Project Reference File and investigated as 
necessary.  Features correlated to the AWOIS item are included in the 
H#####_Final_Feature_File.hob layer and labeled with the appropriate AWOIS number and 
include a remark detailing the search methods and a recommendation from the Hydrographer.  
Items will be attributed as AWOIS for reporting purposes.  Any features that are submitted as 
dangers to navigation (DTON) will be attributed accordingly for reporting purposes.  The 
status of Primary or Secondary may be attributed to aid in deconflicting multiple positions or 
instances of the same feature.  
 
Images are labeled and associated with a DP/userid number or other descriptive/unique name.  
They are included with the survey data and stored in the CARIS/Multimedia folder with the 
deliverables.  References to the images are listed with file extension and comma delimited in 
the Images attribute for the specific feature. 
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare 
MBES coverage and features simultaneously.  The current NOAA object catalog will be used 
for CARIS Notebook processing and the version of such will be documented in the individual 
Descriptive Reports, along with any deviations in shoreline processing from those listed above. 
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Final shoreline deliverables are two S-57 (*.000) files exported from Notebook, the H##### 
Original Composite Source and the H##### Final Feature File, included with the processed 
data.   
 

3.0 Data Review 

Specific procedures are used on Fairweather to ensure quality control of data throughout 
acquisition, processing, and submission.  These procedures are documented and followed by 
the Hydrographer.  A detailed Quality Control check is performed by the survey manager.  A 
detailed review is conducted by qualified survey personnel (FOO, CST, SST, or PS) other than 
the survey manager as an outside review of the survey data and deliverables.  Submission 
checklists are used to ensure that all data and deliverables are complete and included upon 
submission.  Documentation of these tasks is completed for every survey but only the final 
processing log, H##### Data Log, is included in the Separates submitted with the individual 
survey data. 
 

D. Corrections to Echo Soundings 

1.0 Vessel HVFs 

CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a 
vessel’s offsets and measurement uncertainty.  The HVF is used for converting and processing 
raw Hypack .hsx and .raw files to CARIS HIPS HDCS format.   The HVFs used for a given 
project are included with the digital data submitted with the survey.   
 

2.0 Vessel Offsets  

Sensor offsets are measured with respect to each vessel’s reference point.  The reference point 
for Fairweather and her survey launches 2805, 2806, 2807, and 2808 is the top, center of the 
POS MV IMU (Figure 9).  The offset values from the reference point to the primary GNSS 
antenna are entered into Applanix’s POSView POS MV monitoring software so that all raw 
position data are centered at the vessel’s reference point.  The CARIS HVF contains the offset 
from the vessel’s reference point to the multibeam sonar reference point. 
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Figure 9: Vessel Reference Point (Top of 
POS MV IMU) & Primary GNSS Antenna (port side). 

 
 
Additionally, the Reson 7125 sonar mounting offsets measured from the center of each 
projector to the center of the transceiver are entered in the Reson 7125 hardware configuration 
with the 7K Center for both the 400 kHz and 200 kHz projectors.  The measured values are 
used instead of Reson’s default values because Fairweather’s mounts are slightly different 
than of Reson’s standard sonar mount (Figure 10).   
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Figure 10: Reson 7125 sonar mounting with 400kHz and 200kHz offsets respectively. 

 
 
Permanent control points were established on launches 2805, 2806, 2807, and 2808 during 
construction at All American Marine in 2009.  Sensor offsets were measured by NGS in 
January 2010 using the methods described in the report on each launch located in Appendix II 
of this report.  The resultant offsets, measurements, derivations, descriptions of methodology 
used, diagrams, and coordinate system references are included in the respective vessel’s 
Offsets & Measurements spreadsheet also included in Appendix II.   
 
Launch 2808 also had the Reson 8125 mounted in a tilted head configuration on September 11, 
2013.  Offsets for use in the HVF were measured in September 2010 and are documented in 
Appendix II.  
 
 

3.0 Static and Dynamic Draft 

The static drafts (Waterline Height in the HVF) for launches 2805, 2806, 2807, and 2808 were 
calculated based on steel tape and plumb bob measurements of the distance from benchmarks 
on the port and starboard quarter of the vessel to the waterline.  The values and calculations for 
static draft of the various launches are listed in the respective Waterline Measurement 
spreadsheets included in Appendix II of this report.  New values were inconclusive for 2806 
and 2807; therefore previous values were retained as no modifications were made to the 
vessels since the previous measurements. 
 
The dynamic draft data were acquired for launches 2805, 2806, 2807, and 2808 in Seattle, WA 
in Lake Washington.  The measurements were made using the change in ellipsoid height while 
the vessels were transiting at different speeds in their respective locations.  The ellipsoid 
heights were determined using Post Processed Kinematics (PPK) by recording POSPac data on 
each vessel and then processing the data with local reference stations in Applanix POSPac 
MMS software. The resulting Single Best Estimate of Trajectory (SBET) was exported from 
POSPac and the speed versus ellipsoid height was fit to a third order polynomial curve using a 
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least squares fit method in a Python Script written by NOAA personnel and implemented 
within Pydro.  The polynomial curve was used to derive the table used in the CARIS HVF, and 
the standard deviation of the residuals was used to determine the associated uncertainty in the 
measurement.  Written reports for each platform including initial measurement notes, graphs, 
and finalized values are provided in Appendix II of this report.  The polynomial best fit curve 
of the ellipsoidal height differences from launches 2805, 2806, 2807, and 2808 compare well 
with each other and previous years.  The dynamic draft offset values and standard deviations 
were then entered into the CARIS HVFs. 
 

4.0 Patch Tests 

Patch tests were conducted in accordance with section 5.2.4.1 of the HSSD on launches 2805 
and 2808 for the Reson 7125 SV MBES sonar systems during the month of April 2013 using 
the Shilshole Bay Reference Surface and Patch Test site near Seattle, WA.  Launches 2806 and 
2807 Reson 7125 SV MBES sonar systems were patch tested September 2013 when the 
launches were brought back online after being inactive for two years.  Launch 2805 was re 
patch tested in September 2013 and values post dated in HVF for season use.  The results of all 
patch tests to date, along with the acquisition and processing logs, are included in the 
individual MBES Calibration files in Appendix II.   
 
Also included in Appendix II is the sounding system comparison.  This comparison includes 
surface differencing between launch reference surfaces using CARIS Bathy Database.  The 
result of the comparison shows that the differences between each platform and sonar are within 
NOAA specification for vertical uncertainty. 

5.0 Attitude and Kinematic Data 

Vessel attitude is measured by the POS MV and recorded in the Hysweep .hsx file.  Roll is 
corrected in real time for Reson 7125 SV data.  Attitude correctors not applied in real time 
(heave, pitch, roll, and heading) are applied during post processing in CARIS HIPS using the 
raw POS MV attitude data recorded in the Hysweep .hsx file.  Post processed kinematic (PPK) 
data from the POS MV .000 file are applied to MBES data in CARIS HIPS in the form of 
SBET files once all data acquisition is complete.    
 
5.1 TrueHeave™ 

The POS MV TrueHeave™  data is logged within the POS MV .000 files and applied in 
CARIS HIPS during post processing using the “Apply TrueHeave” function during sound 
speed correction.  TrueHeave™ is a forward-backward filtered heave corrector as opposed to 
the real time heave corrector, and is fully described in Section 6 of the POS MV V4 User Guide 
2009.  To ensure proper application in CARIS HIPS, POS MV files are logged for at least three 
to five minutes before and after all MBES files are logged.  
 
In cases where TrueHeave™ cannot be applied, real time heave correctors are used.  Real time 
heave data are recorded and stored in the Hypack Hysweep .hsx file and are applied as the 
heave corrector for MBES data if TrueHeave™ files are unavailable.  Data that do not have 
TrueHeave™ applied will be listed in the individual Descriptive Report for the survey.  
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5.2 Post Processed Kinematic Data 

 
Post Processed Kinematic (PPK) data in the form of Single Best Estimate of Trajectory 
(SBET) files are applied to soundings to increase the accuracy of the kinematic vessel 
corrections and to allow the ability to reference soundings to the ellipsoid.   
 
Standard daily data processing procedures aboard Fairweather include post processing of POS 
MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software using either 
Single Base batch processing or SmartBase processing.  After processing and quality control 
analysis of the post-processed SBET files is complete, the SBET and SMRMSG files are 
applied to the HDCS data in CARIS HIPS using the “Load Attitude/Navigation Data”, the 
“Load error data”, and “Compute GPS Tide” processing tools.  Ellipsoidal heights are 
contained within the PPK SBET files.  Soundings to which SBETs have been applied can be 
reduced to the ellipsoid by merging the data in CARIS HIPS with “GPS Tide” applied.  Data 
are frequently referenced to the ellipsoid during data analysis for troubleshooting unexplained 
vertical offsets, but are reduced back to MLLW for data finalization and submission.  
 
Feature and bottom sample positions are not corrected with post processed GNSS data because 
at this time as there is not a developed nor streamlined procedure for PPK application to 
features. 
 
 

6.0 Sound Speed 

Seabird SBE 19plus and SBE 19plusV2 sound speed profilers are used regularly to collect 
sound speed data for the Reson 7125 SV MBES systems on survey launches 2805, 2806, 2807, 
and 2808.  
 
Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed 
with Velocipy and concatenated into single .svp files for each vessel per survey.  Individual 
.svp files and the concatenated vessel files for the survey are submitted with each survey.    
 
The concatenated sound speed files are applied to multibeam data in CARIS HIPS during data 
processing.  CARIS HIPS uses one of four different methods to automatically apply a sound 
speed profile stored in a concatenated sound speed file.  They are: “previous in time,” “nearest 
in time,” “nearest in distance” and “nearest in distance within time.”  The method of applying 
sound speed for a specific day of data collection is listed in the daily logs included as Separates 
submitted with the individual survey data. 
 

7.0 Water Level 

Unless otherwise noted in the survey Descriptive Report, the vertical datum for all soundings 
and heights is Mean Lower Low Water (MLLW).  Predicted, preliminary, and/or verified water 
level correctors from the primary tide station(s) listed in the Project Instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course 
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of the project.  These tide station files are collated to include the appropriate days of 
acquisition and then converted to CARIS .tid file format using FetchTides.   
 
Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone 
definition file (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied 
by CO-OPS.   Upon receiving final approved water level data, all data are reduced to MLLW 
using the final approved water levels as noted in the individual survey’s Descriptive Report. 
 
If available, a VDATUM model comparison might be requested by Office of Coast Survey, 
Operations Branch.  If accepted, CARIS HIPS data may be reduced to MLLW per supplied 
separation model instead of through traditional water level application.  See the individual 
survey’s Descriptive Report for further information. 
 
A complete description of vertical control utilized for a given project can be found in the 
project specific Horizontal and Vertical Control Report (HVCR), submitted for each project 
under separate cover when necessary as outlined in section 5.2.3.2.3 of the FPM. 
 



Appendix I 
 
 
System Tracking 
 

1. Vessel Inventory 
2. Hardware Inventory 
3. Computer Inventory 

 
Sound Speed Calibration Documentation 
 

1. SPE 19+  
2. SPE 19+ V2 
3. SVP 70 
4. SVP 71 
5.  ODOM Digibar 

 



Field Unit: FAIRWEATHER
Effective Date: September 13, 2010

Updated Through: November 11, 2010

Vessel Name FAIRWEATHER Launch 2805 Launch 2806 Launch 2807 Launch 2808 RA Launch 2801

Hull Number S 220 2805 2806 2807 2808 2801

Call Letters WTEB

Manufacturer Aerojet-General Shipyards All American Marine All American Marine All American Marine All American Marine All American Marine

Year of Construction 1967 2009 2009 2009 2009

Type of Construction Welded steel hull -
 ice strengthened Welded Aluminum Welded Aluminum Welded Aluminum Welded Aluminum Welded Aluminum 

Length Overall 70.4 m (231') 8.64 m (28' 6") 8.64 m (28' 6") 8.64 m (28' 6") 8.64 m (28' 6") 8.64 m (28' 6")

Beam 12.8 m (42') 3.48 m (11' 5") 3.48 m (11' 5") 3.48 m (11' 5") 3.48 m (11' 5") 3.48 m (11' 5")

Draft 4.7 m (15' 6") 1.12 m (3' 8") 1.12 m (3' 8") 1.12 m (3' 8") 1.12 m (3' 8") 1.12 m (3' 8")

Cruising Speed 12.5 knots 24 knots 24 knots 24 knots 20 knots 20 knots

Max Survey Speed 8 knots 8 knots 8 knots 8 knots 8 knots 8 knots

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/23/2003       
POS/MV Offsets Surveyed 2/2007 

and 2/15/2009
1/26/2010 1/26/2010 1/27/2010 1/27/2010 3/31/2008

Organization which Conducted 
the Effective Full Offset Survey

Original Survey -  Westlake 
Consultants                   

POS/MV Spatial Surveys - NGS
NGS/GSD NGS/GSD NGS/GSD NGS/GSD NGS/GSD

Date of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a n/a n/a n/a n/a n/a

Date of Last Static Draft 
Determination & Method Used

6/13/2011                     
Draft Marks                   

4/01/2013
Direct Measurement from 

benchmarks.

3/17/2011
Direct Measurement from 

benchmarks.

3/9/2011
Direct Measurement from 

benchmarks.

4/03/2013
Direct Measurement from 

benchmarks.

3/2/2013                   
Direct Measurement from 

Benchmarks.
Date of Last Settlement and 
Squat/Dynamic Draft 
Measurements & Method Used

4/19/2012                     
Post Processed Kinematic 
(Ellipsoidally referenced)

4/01/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

9/01/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

9/3/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

4/08/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

3/2/2013

YELLOW - info needs to be verified

ORANGE - info to be checked/updated

GREY - not applicable

Hydrographic Vessel Inventory

SURVEY VESSELS



































Inventory

Last Updated: Fairweather Software Inventory
2/4/2013
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 Unlimited 5-Keys
FA P1 Process 1 7.1.2.5 3.1.1.1 4.0.0.0 5.1.1.1 12.9  (r3965) 6.1 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0 BETA 3.1.1.1 4.0.0.0 5.1.1.1 12.9  (r3965) 11 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0 BETA 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 7.3.0 (64bit) 10.0.0 2.6 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 2.6 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 10.0.0 2.6 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 11.0.1.49 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 11.0.1.49 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 12.0.0.1 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2.6 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.0 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.0 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.0 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.0 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 Unlimited 5-Keys
FA P1 Process 1 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 11 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 7.3.0 (64bit) 10.0.0 2.6 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 11 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 2.6 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 8.0.4 3.1.1.1 3.2.2.2 5.1.1.1 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 8.0.4 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 8.0.4 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 11.0.1.49 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 11.0.1.49 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 12.0.0.1 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2.6 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.1 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.1 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.1 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys
FA P1 Process 1 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.0 (64bit) 10.0.0 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 8.0.2 3.1.1.1 4.0.0.3 5.2 13.8  (r4311) 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 13.0.0.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 10.5 5.4 SP2 10.0.0 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 8.0.4 3.1.1.1 3.2.2.2 5.1.1.1 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 8.0.4 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 8.0.4 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 13.0.0.6 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.1 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.1 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.1 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys
FA P1 Process 1 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 2.7 7.3.5a 10.0.0 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 2.7 7.3.5a 10.0.0 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 7.1.2.6 3.1.1.1 4.0.0.3 5.2 13.8  (r4311) 6.2 2.7 7.3.5a 10.0.0 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 7.1.2.6 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 7.3.5a 10.0.0 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.6 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 11 6.2 7.3.5a 10.0.0 13.0.0.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.2.6 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 11 6.2 10.0.0 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.6 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 6.2 10.0.0 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.6 3.1.1.1 3.2.2.4 5.1.1.1 13.8 (r4311) 10.5 6.2 7.3.5a 10.0.0 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1FA P3 Process1 7.1.2.6 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 10.5 6.2 7.3.5a 10.0.0 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 7.1.2.6 3.1.1.1 3.2.2.2 5.1.1.1 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 7.1.2.6 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 7.3.5a 10.0.0 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 7.1.2.6 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.1 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.1 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.1 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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Customer: Pacific Marine Center / NOAA

Job Number: 71841

Model Number SBE 19Plus

Date of Report: 1/21/2013

Serial Number: 19P31464-4343

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/19/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00053 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4343

CALIBRATION DATE: 19-Jan-13

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.201200e-003

a1 =  2.637740e-004

a2 = -4.502162e-008

a3 =  1.503142e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   0.9999            693461.410             1.0000              0.0001

   4.4999            619965.967             4.4998             -0.0001

  15.0000            434193.607            15.0002              0.0002

  18.5000            383468.783            18.4999             -0.0001

  23.9999            313992.967            23.9999              0.0000

  29.0000            260624.433            28.9999             -0.0001

  32.5000            228178.250            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 71841

Model Number SBE 19Plus

Date of Report: 1/21/2013

Serial Number: 19P31464-4343

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/19/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4343

CALIBRATION DATE: 19-Jan-13

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.035501e+000

h =  1.425434e-001

i = -2.565273e-004

j =  3.764616e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2699.23     0.0000      0.00000

   0.9999    34.8497    2.97854    5312.21     2.9785     -0.00001

   4.4999    34.8293    3.28582    5511.25     3.2858      0.00001

  15.0000    34.7856    4.26825    6103.45     4.2683      0.00001

  18.5000    34.7746    4.61343    6298.06     4.6134      0.00000

  23.9999    34.7615    5.17136    6600.20     5.1714     -0.00001

  29.0000    34.7512    5.69285    6870.31     5.6928     -0.00001

  32.5000    34.7416    6.06444    7056.28     6.0644      0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4343

CALIBRATION DATE: 17-Jan-13

SBE19plus PRESSURE CALIBRATION DATA

 1450 psia S/N 2101

 

COEFFICIENTS:

PA0 =    6.662245e-001

PA1 =    4.437491e-003

PA2 =   -2.626252e-011

PTEMPA0 = -8.012708e+001

PTEMPA1 =  4.648875e+001

PTEMPA2 = -1.914972e-001

PTCA0 =  5.211780e+005

PTCA1 =  8.212492e+000

PTCA2 = -6.270641e-002

PTCB0 =  2.480825e+001

PTCB1 = -3.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.79 524514.0   2.2       14.81   0.00         32.50     2.45   524615.63

  301.75 589165.4   2.2      301.67  -0.01         29.00     2.37   524606.26

  588.85 653903.0   2.2      588.69  -0.01         24.00     2.26   524585.64

  875.69 718691.2   2.2      875.71   0.00         18.50     2.14   524549.45

 1162.53 783439.3   2.2     1162.34  -0.01         15.00     2.06   524523.54

 1449.63 848380.3   2.2     1449.60  -0.00          4.50     1.83   524451.31

 1162.54 783530.8   2.2     1162.74   0.01          1.00     1.76   524430.35

  875.62 718688.1   2.2      875.70   0.01

  588.62 653913.7   2.2      588.73   0.01         TEMP(ITS90)   SPAN(mV)

  301.62 589155.5   2.2      301.62  -0.00            -5.00       24.81

   14.78 524513.8   2.2       14.80   0.00            35.00       24.80

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P36026-4617

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 15-Jan-13

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.988382e-001

h =  1.277109e-001

i = -2.422985e-004

j =  3.298924e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2801.23     0.0000      0.00000

   1.0000    34.9579    2.98691    5593.60     2.9869     -0.00001

   4.4999    34.9380    3.29506    5805.19     3.2951      0.00001

  14.9999    34.8945    4.28018    6434.28     4.2802     -0.00000

  18.4999    34.8842    4.62639    6640.94     4.6264      0.00001

  23.9999    34.8718    5.18596    6961.65     5.1860     -0.00001

  29.0000    34.8625    5.70903    7248.27     5.7090     -0.00001

  32.5000    34.8528    6.08163    7445.52     6.0816      0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P36026-4617

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00039 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 15-Jan-13

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.267255e-003

a1 =  2.620479e-004

a2 =  2.503373e-007

a3 =  1.427996e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            585630.288             1.0000              0.0000

   4.4999            518796.780             4.4999             -0.0000

  14.9999            354147.797            14.9999              0.0000

  18.4999            310219.797            18.4999             -0.0000

  23.9999            250754.017            24.0001              0.0002

  29.0000            205618.712            28.9998             -0.0002

  32.5000            178401.119            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 11-Jan-13

SBE19plus PRESSURE CALIBRATION DATA

 1450 psia S/N 5513

 

COEFFICIENTS:

PA0 =   -4.701047e-001

PA1 =    4.447332e-003

PA2 =   -1.304121e-011

PTEMPA0 = -7.822603e+001

PTEMPA1 =  4.830428e+001

PTEMPA2 = -1.958091e-001

PTCA0 =  5.192728e+005

PTCA1 = -1.041390e+001

PTCA2 =  2.558563e-001

PTCB0 =  2.460838e+001

PTCB1 =  6.750000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.76 522594.8   2.1       14.76   0.00         32.50     2.31   522702.93

  301.47 587124.9   2.1      301.52   0.00         29.00     2.24   522693.29

  588.36 651711.6   2.1      588.42   0.00         24.00     2.13   522685.00

  875.32 716329.0   2.1      875.34   0.00         18.50     2.02   522674.61

 1162.35 780976.5   2.1     1162.29  -0.00         15.00     1.95   522671.91

 1449.33 845661.7   2.1     1449.30  -0.00          4.50     1.73   522725.79

 1162.30 781002.2   2.1     1162.41   0.01          1.00     1.65   522776.42

  875.32 716327.8   2.1      875.34   0.00

  588.05 651593.1   2.1      587.89  -0.01         TEMP(ITS90)   SPAN(mV)

  301.46 587111.5   2.1      301.46   0.00            -5.00       24.61

   14.76 522593.5   2.1       14.76  -0.00            35.00       24.63

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/14/2013

Serial Number: 19P50959-6122

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 12-Jan-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.952241e-001

h =  1.571720e-001

i = -5.010477e-004

j =  6.360475e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2523.27     0.0000      0.00000

   1.0000    34.8497    2.97855    5042.82     2.9785     -0.00001

   4.4999    34.8298    3.28586    5233.74     3.2859      0.00001

  14.9999    34.7859    4.26827    5801.21     4.2683     -0.00001

  18.5000    34.7749    4.61347    5987.57     4.6135      0.00000

  24.0000    34.7616    5.17139    6276.75     5.1714      0.00001

  29.0000    34.7500    5.69268    6535.02     5.6927      0.00000

  32.5000    34.7379    6.06386    6712.66     6.0639     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/14/2013

Serial Number: 19P50959-6122

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00110 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 12-Jan-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.311436e-003

a1 =  2.512171e-004

a2 =  7.670896e-007

a3 =  1.064799e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            640406.164             1.0000              0.0000

   4.4999            567830.450             4.4999             -0.0000

  14.9999            387717.410            14.9998             -0.0001

  18.5000            339443.533            18.5001              0.0001

  24.0000            274050.383            24.0000             -0.0000

  29.0000            224422.115            29.0000             -0.0000

  32.5000            194529.770            32.5000              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 11-Jan-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752080

 

COEFFICIENTS:

PA0 =   -1.625248e-001

PA1 =    2.635779e-003

PA2 =    2.061527e-011

PTEMPA0 = -6.146598e+001

PTEMPA1 =  5.373745e+001

PTEMPA2 = -2.607578e-001

PTCA0 =  5.244217e+005

PTCA1 = -1.948462e+000

PTCA2 = -5.889249e-002

PTCB0 =  2.507825e+001

PTCB1 = -5.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.71 530001.0   1.5       14.72   0.00         32.50     1.76   530074.05

  179.99 592641.0   1.5      179.99   0.00         29.00     1.70   530095.03

  360.00 660791.0   1.5      359.99  -0.00         24.00     1.60   530119.00

  540.02 728880.0   1.5      540.02  -0.00         18.50     1.50   530143.08

  720.05 796899.0   1.5      720.05   0.00         15.00     1.43   530159.73

  875.06 855399.0   1.5      875.05  -0.00          4.50     1.24   530187.25

  720.08 796915.0   1.5      720.10   0.00          1.00     1.17   530200.03

  540.09 728910.0   1.5      540.10   0.00

  360.06 660813.0   1.5      360.05  -0.00         TEMP(ITS90)   SPAN(mV)

  180.04 592653.0   1.5      180.03  -0.00            -5.00       25.08

   14.72 529999.0   1.5       14.72  -0.00            35.00       25.06

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P50959-6121

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 15-Jan-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.001225e+000

h =  1.548297e-001

i = -3.722102e-004

j =  5.023761e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2548.08     0.0000      0.00000

   1.0000    34.9579    2.98691    5085.03     2.9869      0.00002

   4.4999    34.9380    3.29506    5277.33     3.2950     -0.00003

  14.9999    34.8945    4.28018    5849.25     4.2802      0.00001

  18.4999    34.8842    4.62639    6037.13     4.6264      0.00001

  23.9999    34.8718    5.18596    6328.72     5.1860     -0.00000

  29.0000    34.8625    5.70903    6589.32     5.7090     -0.00001

  32.5000    34.8528    6.08163    6768.66     6.0816      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P50959-6121

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00058 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 15-Jan-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.295516e-003

a1 =  2.542861e-004

a2 =  4.335425e-007

a3 =  1.208696e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            648465.131             1.0000              0.0000

   4.4999            575538.623             4.4999             -0.0000

  14.9999            394119.067            14.9999             -0.0000

  18.4999            345384.617            18.5000              0.0001

  23.9999            279281.852            23.9999             -0.0000

  29.0000            229047.393            29.0000              0.0000

  32.5000            198761.600            32.5000              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 11-Jan-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752079

 

COEFFICIENTS:

PA0 =   -2.168329e-001

PA1 =    2.639989e-003

PA2 =    1.757815e-011

PTEMPA0 = -5.976510e+001

PTEMPA1 =  5.349302e+001

PTEMPA2 = -4.374279e-001

PTCA0 =  5.247699e+005

PTCA1 = -5.009466e+000

PTCA2 =  4.527557e-002

PTCB0 =  2.511463e+001

PTCB1 = -1.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.76 530357.0   1.5       14.77   0.00         32.50     1.75   530473.02

  180.02 592862.0   1.5      180.01  -0.00         29.00     1.68   530482.08

  360.04 660899.0   1.5      360.04   0.00         24.00     1.59   530496.28

  540.06 728872.0   1.5      540.06   0.00         18.50     1.48   530512.41

  720.08 796790.0   1.5      720.10   0.00         15.00     1.41   530522.78

  875.07 855198.0   1.5      875.05  -0.00          4.50     1.21   530565.61

  720.09 796792.0   1.5      720.10   0.00          1.00     1.15   530585.51

  540.10 728886.0   1.5      540.10  -0.00

  360.08 660913.0   1.5      360.08  -0.00         TEMP(ITS90)   SPAN(mV)

  180.07 592875.0   1.5      180.05  -0.00            -5.00       25.12

   14.76 530351.0   1.5       14.76  -0.00            35.00       25.08

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 22-Aug-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.858560e-001

h =  1.406405e-001

i = -2.133730e-004

j =  3.563735e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2650.57     0.0000      0.00000

   1.0052    34.8099    2.97592    5309.92     2.9759     -0.00001

   4.5000    34.7893    3.28243    5510.86     3.2824      0.00002

  15.0000    34.7475    4.26407    6109.26     4.2641     -0.00001

  18.5000    34.7385    4.60916    6305.88     4.6092      0.00000

  24.0000    34.7287    5.16703    6611.07     5.1670      0.00000

  29.0000    34.7224    5.68867    6883.88     5.6887     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 22-Aug-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.267939e-003

a1 =  2.728750e-004

a2 = -1.197541e-006

a3 =  1.872534e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0052            563301.525             1.0053              0.0001

   4.5000            497154.136             4.4999             -0.0001

  15.0000            335314.542            15.0002              0.0002

  18.5000            292515.729            18.4999             -0.0001

  24.0000            234866.966            23.9999             -0.0001

  29.0000            191350.051            29.0001              0.0001

  32.5000            165226.051            32.5000             -0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 16-Aug-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 3874647

 

COEFFICIENTS:

PA0 =    1.958656e+000

PA1 =    2.645782e-003

PA2 =    2.212452e-011

PTEMPA0 = -6.436287e+001

PTEMPA1 =  5.272571e+001

PTEMPA2 = -3.391841e-001

PTCA0 =  5.243849e+005

PTCA1 =  4.683156e+001

PTCA2 = -5.575220e-001

PTCB0 =  2.507550e+001

PTCB1 = -3.000000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.60 529892.0   1.6       14.58  -0.00         32.50     1.86   530289.59

  179.89 592287.0   1.6      179.80  -0.01         29.00     1.79   530249.11

  359.90 660195.0   1.6      359.81  -0.01         24.00     1.69   530163.80

  539.92 728037.0   1.6      539.86  -0.01         18.50     1.59   530036.31

  719.93 795795.0   1.6      719.89  -0.01         15.00     1.52   529934.00

  874.92 854081.0   1.6      874.91  -0.00          4.50     1.32   529551.97

  719.95 795842.0   1.6      720.01   0.01          1.01     1.25   529410.13

  539.95 728102.0   1.6      540.03   0.01

  359.94 660274.0   1.6      360.01   0.01         TEMP(ITS90)   SPAN(mV)

  179.92 592368.0   1.6      180.00   0.01            -5.00       25.08

   14.61 529928.0   1.6       14.65   0.00            35.00       25.07

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2
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Appendix II 
 
 
Vessel Reports, Offsets, and Diagrams 
 
Launch 2801 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
Launch 2805 

5. Offsets 
6. Patch Test 
7. POS MV GAMS Calibration 
8. Dynamic Draft 

 
Launch 2806 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
Launch 2807 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
Launch 2808 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
S-220 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 

 
Coordinate Systems Utilized in Vessel Offsets 
 



RA‐4 (2801) FWD Keel BM to Sonar Crew:  McGovern, Jackson, Geiger, Phillips
HF LF 6 March 2013 (DN065)

x (+fwd) ‐0.4811 ‐0.4830 Vessel Orientation during measurement( ) g
y (+stbd) 0.0010 0.0010 Pitch ‐0.03
z (+down) ‐0.1620 ‐0.1850 Roll ‐0.05

Offset vector corrected for pitch Counter Pitch Matrix
x (+fwd) ‐0.4811 ‐0.4831 1.0000 0.0000 0.0006( )
y (+stbd) 0.0010 0.0010 0.0000 1.0000 0.0000
z (+down) ‐0.1617 ‐0.1847 ‐0.0006 0.0000 1.0000

Offset vector corrected for roll Counter Roll Matrix
x (+fwd) ‐0.4811 ‐0.4831 1.0000 0.0000 0.0000

Remember to reverse the X and Y 
coordinates when shifting from ( )

y (+stbd) 0.0011 0.0011 0.0000 1.0000 ‐0.0008
z (+down) ‐0.1617 ‐0.1847 0.0000 0.0008 1.0000

Sonar coordinates corrected for NGS BM 2012 for Reference
HF LF NGS 2801 BM Coordintes HF LF Differences

Remember to reverse the X and Y 
coordinates when shifting from 
POS coordinate system to CARIS 
coordinate system!!!

x (+fwd) 0.0539 0.0519 x (+fwd) 0.535 0.055 0.053 ‐0.001 ‐0.001
y (+stbd) 0.0051 0.0051 y (+stbd) 0.004 0.003 0.003 0.002 0.002
z (+down) 0.4443 0.4213 z (+down) 0.606 0.444 0.426 0.000 ‐0.005

tami.beduhn
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RA‐4 (2801) Crew:  McGovern, Jackson, Geiger, Phillips
(HORIZONTAL ‐ Enter horizontal distance between points) 6 March 2013 (DN065)
a  (port‐to‐stbd) 1.434
b  (BM‐to‐port) 0.988
c  (BM‐to‐stbd) 0.983

Measured offset vector (Cabin BM to Antenna)
Port GPS Stbd GPS

x (+fwd) ‐0.676 ‐0.676 Vessel Orientation during measurement
y (+stbd) ‐0.720 0.714 Pitch ‐0.07
z (+down) ‐0.485 ‐0.490 Roll 0.00

Offset vector corrected for pitch Counter Pitch Matrix POSPAC 2012 Diff
x (+fwd) ‐0.6769 ‐0.6769 1.0000 0.0000 0.0012 x (+fwd) ‐0.7681 ‐0.003
y (+stbd) ‐0.7202 0.7138 0.0000 1.0000 0.0000 y (+stbd) ‐0.7219 0.003
z (+down) ‐0.4837 ‐0.4892 ‐0.0012 0.0000 1.0000 z (+down) ‐3.1699 0.028

Offset vector corrected for roll Counter Roll Matrix POSPac GAMS  (Differences)
x (+fwd) ‐0.6769 ‐0.6769 1.0000 0.0000 0.0000 x (+fwd) ‐0.026 0.026
y (+stbd) ‐0.7202 0.7138 0.0000 1.0000 0.0000 y (+stbd) 1.436 ‐0.002
z (+down) ‐0 4837 ‐0 4892 0 0000 0 0000 1 0000 z (+down) 0 005 ‐0 010z (+down) ‐0.4837 ‐0.4892 0.0000 0.0000 1.0000 z (+down) 0.005 ‐0.010

Separation 1.437 ‐0.003
Antenna coordinates corrected for Cabin BM

Port GPS Stbd GPS Cabin BM Coordinates Baseline vector Real‐time GAMS (Differences)
x (+fwd) ‐0.7709 ‐0.7709 x (+fwd) ‐0.094 x (+fwd) 0.000 ‐0.03 0.030
y (+stbd) ‐0.7192 0.7148 y (+stbd) 0.001 (NGS) y (+stbd) 1.434 1.445 ‐0.011
z (+down) ‐3.1417 ‐3.1472 z (+down) ‐2.658 (NGS) z (+down) ‐0.005 0.012 ‐0.017

Remeasure Ant. Separation 1.434 1.446 ‐0.012
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Vessel ‐ 2801_Reson7125_LF_256
Date Acquired ‐ 

Value Line(s) Used Value Lines Used Value Lines Used Value Lines Used Value Lines Used initials
Trial 1 BJ 0.00 ‐0.226 1706,1708 ‐0.25 1726,1727 0.428 1716,1723 0.388 1716,1721 JD
Trial 2 WC 0.00 ‐0.24 1726,1727
Trial 3 RB 0.00 ‐0.41 1706,1708 ‐0.24 1726,1727 0.328 1716,1723
Trial 4 BB 0.00 ‐0.232 1726,1727
Trial 5 JC/RA 0.00 ‐0.56 1706,1708 ‐0.256 1726,1727 0.494 1716,1723 0.1 1718,1723 JK
Trial 6 MEM 0.00 ‐0.49 1706,1708 0.382 1716,1723 0.272 1716,1721. MEM
Trial 7 JBJ 0.00 ‐0.53 1706,1708 0.486 1716,1723 0.4575 1716/1721 & 1718/1723 mog
average 0.000 ‐0.498 ‐0.244 0.424 0.304
std. dev. 0.000 0.066 0.010 0.070 0.156

Values entered in HVF… Uncertainties entered in HVF… All YAW
Timing (s) 0.000 Timing (s) AVG 0.423357143
Roll (°) ‐0.244 MRU Roll/Pitch 0.067 Std Dev 0.060766434
Pitch (°) ‐0.498
Yaw (°) 0.423 MRU Gyro 0.061

User Initials
TIMING (s) PITCH (°) ROLL (°) YAW (°) YAW (°) 2



Vessel ‐ 2801_Reson7125_HF_512
Date Acquired ‐

Value Line(s) Used Value Lines Used Value Lines Used Value Lines Used Value Lines Used Initials
Trial 1 BJ 0.00 ‐0.528 1740,1742 ‐0.22 1758, 1759 0.724 1751,1756
Trial 2 RB 0.00 ‐0.64 1740,1742 ‐0.224 1758,1759 0.638 1751,1756
Trial 3 RA 0.00 ‐0.47 1740,1742 ‐0.198 1758,1759
Trial 4 BB 0.00 ‐0.198 1758,1759 0.068 1753,1756A JK
Trial 5 WC/JBJ 0.00 ‐0.214 1758,1759 0.656 1751,1756 0.39 1753,1756A JC
Trial 6 MEM 0.00 ‐0.435 1740,1742 0.73 1751,1756 0.468 1751,1755 MEM
Trial 7 CM/AS 0.00 ‐0.24 1740,1742 0.684 1751,1756 0.442 1751,1755 JD
Trial 8 mog 0.00 ‐0.59 all 0.482 1751/1755 & 1753/1756A mog
average 0.000 ‐0.533 ‐0.212 0.686 0.446
std. dev. 0.000 0.083 0.013 0.041 0.041

Values entered in HVF… Uncertainties entered in HVF…
Timing (s) 0.000 Timing (s) All YAW
Roll (°) ‐0.212 MRU Roll/Pitch 0.084 AVG 0.5282
Pitch (°) ‐0.533 Std Dev 0.204340565
Yaw (°) 0.446 MRU Gyro 0.041

User Initials
YAW (°) 2TIMING (s) PITCH (°) ROLL (°) YAW (°)





Vessel 2801  RA4
Date March 14,2013
DN 73

0.5
Ellipsoidally Referenced
Processing Interval? 20:32:40 22:29:00

419560 426540
Polynomial Order (3rd or 4th)? 3rd



0.5 0.0491

2012 ER (3rd O.) 3rd/4th O. Diff 2012 ER (4th O.)
Draft (m) Speed (m/s) (~2kt vs. slack) Draft (m) Speed (m/s

0.00 0.0 0.00 0.00 0.0
0.05 0.5 0.07 ‐0.02 0.5
0.09 1.0 0.11 ‐0.02 1.0
0.11 1.5 0.12 ‐0.01 1.50.11 1.5 0.12 0.01 1.5
0.13 2.0 0.12 0.01 2.0
0.13 2.5 0.11 0.02 2.5
0.13 3.0 0.09 0.04 3.0
0.12 3.5 0.08 0.04 3.5
0.10 4.0 0.06 0.04 4.0
0.08 4.5 0.05 0.03 4.5
0.05 5.0 0.05 0.00 5.0
0.02 5.5 0.06 ‐0.04 5.5
‐0.02 6.0 0.07 ‐0.09 6.0
‐0.06 6.5 0.09 ‐0.15 6.5
‐0.10 7.0 0.12 ‐0.22 7.0
‐0.14 7.5 0.15 ‐0.29 7.5
‐0.19 8.0 0.17 ‐0.36 8.0
‐0.23 8.5 0.20 ‐0.43 8.5
‐0.27 9.0 0.21 ‐0.48 9.0
‐0.30 9.5 0.22 ‐0.52 9.5
‐0.34 10.0 0.20 ‐0.54 10.0

1σ ‐ Uncert. 0.053 0.050
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Ellipsoidally Referenced
Processing Interval? 20:32:40 22:29:00

419560 426540
Polynomial Order (3rd or 4th)? 4th



0.5 ‐0.01909

2013 MB 2011 Reference 2012 MB
s) Draft (m) Speed (m/s) kts Draft (m) Speed (m/s) Draft (m) Speed (m/s)

0.000 0.0 0 0.00 0.0 0.000 0.0
0.033 2.35 4.5719617 ‐0.01 0.5 0.017 2.30
0.070 3.36 6.5352616 ‐0.01 1.0 0.054 3.26
0.082 3.90 7.5888345 0.00 1.5 0.081 3.760.082 3.90 7.5888345 0.00 1.5 0.081 3.76
0.073 4.30 8.3556877 0.01 2.0 0.077 4.21
0.040 4.69 9.1128217 0.03 2.5 0.048 4.71
‐0.063 5.79 11.259816 0.04 3.0 ‐0.044 5.90
‐0.200 7.18 13.947205 0.05 3.5 ‐0.156 7.71

0.05 4.0
2013 HVF ENTRY 0.04 4.5
Caris bug needs knots 0.01 5.0

‐0.02 5.5
‐0.05 6.0
‐0.10 6.5
‐0.14 7.0
‐0.18 7.5
‐0.22 8.0
‐0.25 8.5
‐0.26 9.0
‐0.24 9.5
‐0.19 10.0

0.025
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BM to Water line  HEIGHT NGS Difference Ave. Std. Dev. 2012 Waterline 2011 Waterline

2801 RA‐4 Fuel: 103/120
PORT 0.987 1.078 ‐0.091

0.991 1.078 ‐0.087
0.984 1.078 ‐0.094

PORT Ave & Stdev ‐0.091 0.004

STBD 0.997 1.078 ‐0.081
1.003 1.078 ‐0.075
0.994 1.078 ‐0.084

STBD Ave & Stdev ‐0.080 0.005

2013 HVF Entries Average of Six Observations ‐0.085 2012 Reference 2011 Reference
2013 Draft Uncertainty Max. of Two Stdev 0.005 ‐0.099 ‐0.099



ALL Differences Relative to 2801 HF

MLLW Difference Relative to 2801 HF
Sensor 1 Multibeam
2801 HF 0.00
2801 LF 0.01
2802 HF 0.01
2802 LF ‐0.01
2803 HF 0.01
2803 LF 0.03
2803 8125 ‐0.01
2804 HF ‐0.01
2804 LF ‐0.02

Ellipse Difference Relative to 2801 HF
Sensor 1 Multibeam
2801 HF 0.00
2801 LF 0.02
2802 HF ‐0 03
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2013 Relative Depth Comparison of Rainier Reference Surfaces (referenced to MLLW and 
Ellipse)
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2802 LF ‐0.01
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2804 LF ‐0.03
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Note:  datasets with no 
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for visualization purposes.

D
ee

pe
r



Step #1 ‐ Generate Reference 
Surface for each sonar.

2801 HF DTM
2803 HF DTM

Step #2 ‐ Compute 
Difference Surface.

Step #3 ‐ Compute Difference Surface Statistics.



2805 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.686 n/a Scaler Distance 1.447 -0.682 -0.806 0.000 0.000
y 0.000 0.245 1.051 n/a -0.806 -0.682 0.000 0.000
z 0.000 0.482 3.656 -0.097 -3.174 -3.174 0.000 0.000

*IMU is Reference Point -0.111

Vessel Offsets for 2805 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68217 RP to Waterline (m) IMU to x -0.68217 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.80598 z 0.097 Port Ant (m) y -0.80598 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.17407 (calculated) z 3.17407 z 0.00000 z 0.00000

MBES RP x 0.00401 IMU to 7125 x 0.00401 IMU (m) x, y, z 0.00000 Top of x -0.68217 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24503 Phase Ctr y 0.24503 2010 RP to Waterline (m) Port Ant (m)  y -0.80598 (by design) y 0.00000
Center z -0.48191 (calculated) z -0.48191 z 0.111 Top of x 0.76454 z 3.16277 z 0.00000

Stbd Ant (m)  y -0.80778
z 3.14528 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.08977
Bottom of Stbd Ant
(calculated) (m)  z 3.07228 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to 7125 x 0.00401 x 0.68618 x n/a x -0.68217 x 0.00000

Phase Ctr y 0.24503 y 1.05101 y n/a Scalar Distance 1.4468 y -0.80598 y 0.00000
z -0.48191 z -3.65598 z 0.097 z 3.17407 z 0.00000

Coord. Sys. x 0.00401 Coord. Sys. x 0.68618 Coord. Sys. x n/a Coord. Sys. x ‐0.80598 Coord. Sys. x 0.00000
CARIS y 0.24503 CARIS y 1.05101 CARIS y n/a Pos/Mv y ‐0.68217 Pos/Mv y 0.00000

z 0.48191 z 3.65598 z ‐0.097 z ‐3.17407 z 0.00000

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



2012 2011 Measured Values

Measurement IMU 
aka to RP*
Coord. Sys. Caris Caris Caris
x 0.000 0.534 0.609
y 0.000 0.845 -5.525
z 0.000 0.772 -2.186

*IMU is Reference Point

Vessel Offsets for 2805 K5K are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 y 0.00000

z 0.00000 z 0.00000

KEEL FORE BM x -0.00202 Centerline Stern BM x -0.01735
y 0.44007 y -4.04803
z -0.6141 z 0.67574

KEEL FORE BM to K5K CSBM to Tow PT
Rcvr - Phase x 0.536 x 0.626
Center y 0.405 y -1.477
(measured) z -0.158 (measured) z 1.510

Coord. Sys.
NGS IMU to K5K x 0.53398 IMU to Tow PT K5K x 0.60865

Phase Ctr y 0.84507 y -5.52503
z -0.77210 z 2.18574

Coord. Sys. x 0.53398 Coord. Sys. x 0.60865
CARIS y 0.84507 CARIS y ‐5.52503

IMU to K5K

IMU to K5K

IMU to K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

z 0.77210 z ‐2.18574



Description of Offsets for Launch 2805
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2805 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.447 m Primary Antenna Reference Pt.
7125 Phase Center

-3.174 m

3.656 m
0.245 m

1.051 m

-0.806 m
Primary Antenna Reference Pt.

0.686 m
Port Ant. to 7125 

-0.682 m

IMU 
Reference 

0.004 m

IMU Reference Pt.

1.447 m

2805

0.845 m

0.534 m

K5K Reference Pt.

0.482 m

0.004 m

7125 Phase 
Center

Pt.

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 686 m

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.772 m

0.534 m 
K5K Reference Pt.

x y z x y z x y z x y z x y z
0.004 0.245 0.482 0.686 1.051 3.656 N/A N/A -0.097 -0.682 -0.806 -3.174 0.000 0.000 0.000

IMU to Heave
Scalar Distance

1.447

IMU to 7125 Port Ant to 7125 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
th NGS Th h i l

The values were calculated by 
subtracting the physical height 
of the Port Antenna to the IMU x, 

l f h i

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
B h k t th t li

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z value of the antenna was

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values

0.686 m 
Port Ant. to 7125 

x y z
0.534 0.845 0.772

IMU to K5K

and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 

subtracting the physical height 
of the Port Antenna to the IMU x, 
y, z values from the respective 
values of the IMU to the 7125.  
The calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to CARIS 
coordinates.

location of the top of port 
antenna were surveyed by NGS.  
The z‐value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
l l

7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

initially and is converted to CARIS 
coordinates.

by FAIRWEATHER personnel 
using a steel tape and bubble 
level.
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NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2805.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny early then cloudy with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU.  
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 
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Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
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STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



 
 
 

Appendix A 
 

Coordinate Report Launch 2805 
 
Pt Name      North(Y) East(X) Elev.(Z) ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13270    -0.00348    -0.16937    IMUR  
Centerline Stern BM          -4.04803     0.01735     0.67574     CLS   
Centerline Bow BM    3.46914     0.01735     1.39751     BMB   
Portside GPS Ant. Ref. Point -0.80598    -0.68217     3.16277     GPSP  
Starboard GPS Ant. Ref. Point-0.80778     0.76454     3.14528     GPSS  
Multi-Beam Ref.Point    0.24503     0.00401    -0.48191    MB    
Keel BM      0.44007    -0.00202    -0.61410    MBF   
Keel BM        -0.22895    -0.00227    -0.53363    MBA   
Port Side BM     0.10603    -1.42637     1.07535     BMP   
Starboard Side BM     0.10926     1.45859     1.04250     BMS   
Centerline Cab BM       -0.19024     0.03192     2.65903     BMC 
 
Units = meters 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Appendix B  
 

Point to Point Inverse Launch 2805 
 

Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18        31      0.004     -0.003     0.003    -0.00141  BMC  
 9        29      0.001     0.001    - 0.001     0.00051  BMP  
39        49      0.003    -0.003     0.001    -0.00063  BMS  
 8        48      0.001    -0.001    -0.001     0.00016  CLS  
10        30      0.002    -0.001     0.002     0.00033  GPSP  
11        41      0.000     0.000     0.000     0.00034  GPSS  
16        53      0.001     0.000     0.001     0.00024  IMU  
17        54      0.002     0.000    0.002     0.00029  IMUR  
 4        46      0.006     0.005     0.002    -0.00018  MB  
 5        47      0.001     0.000     0.001     0.00016  MBA  
 3        45      0.002     0.001     0.001    -0.00017  MBF 
 
Units = meters 
 
 
 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

8/28/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

Ferguson, Welton, Wartick, Chensue, Nalley

240 Yaquina River Calm

Launch 2805 200kHz

140 Newport, OR (Yaquina River)

Welton, Wartick, Chensue, Nalley

Reson 7125 2805 ?

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Use 2807

44d37'28.2855"N 124d02'03.8379"W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

110 5.0
110 8.0
290 8.0
290 5.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

110 5.0
290 5.0
110 8.0
290 8.0
290 5.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

110 7.0
290 7.0
110 7.0
290 7.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) RemarksXTF Line Filename

001_2228
001_2230
003_2231
003_2233

XTF Line Filename

002_2204
002_2207 May not have enough time before and after
002_2221
002_2222
002_2225

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename
002_2204
002_2221
002_2222
002_2225

g p ( )
301 7.0
121 7.0
301 6.7
121 6.7

005_2155
005_2158
005_2201

005_2152



Processing Log

8/30/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
2222&2225 2221&2222

0.00 2204&2221 -1.54 2221&2222 -0.12 2152&2155 0.33
0.00 2204&2221 -1.50 2204&2225 -0.13 2152&2155 0.35
0.00 2204&2221 -1.47 2221&2222 -0.11 2152&2201 0.30

0 00 -1 50 -0 12 0 33

Faulkes

Averages

9435380.tid (Prelim)

N/A

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Welton
Beduhn
Wartick

242 Beduhn

Data converted --> HDCS_Data in CARIS

Not applied to 002_2209

NIDWT 2hrs- Not applied to 002_2209

0.00 -1.50 -0.12 0.33
0.00 0.04 0.01 0.03

Resulting HVF File Name

MRU Align StdDev gyro 0.03 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets Updated to beginning of season

Name: Date:

Averages
Standard Deviation

FINAL VALUES

Final Values based on



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

8/28/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

CalmYaquina River

Newport, OR (Yaquina River)

Launch 2805 400kHz

Ferguson, Welton, Wartick, Chensue, Nalley

Welton, Wartick, Chensue, Nalley

?2805

140

Reson 7125

240

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Use 2807

44d37'28.2855"N 124d02'03.8379"W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

290 4.0
290 4.0
290 8.0
109 8.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

290 4.0
109 4.0
290 8.0
109 8.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

290 7.3
109 7.1
290 6.7
109 6.9

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

002_2115

002_2104
002_2108
002_2113

short fat finger line after this one003_2120
003A2122
001_2124

001_2117

XTF Line Filename

XTF Line Filename

XTF Line Filename

XTF Line Filename
002_2108
002_2111
002_2113
002_2115

g p ( )
2 301 7.0
2 122 7.0
2 301 6.9
2 122 7.0

005_2137
005_2139
005_2141
005_2143



Processing Log

8/30/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Lines Used Pitch (deg) Lines Used Roll (deg) Lines Used Yaw (deg)
0.00 2108 &2113 -1.20 2113&2115 -0.16 2137&2139 0.17
0.00 2108 &2113 -1.20 2113&2115 -0.18 2137&2139 0.13
0.00 2108&2113 -1.20 -0.15 0.15
0.00 2108&2113 -1.03 2108&2104 -0.12 2141&2143

0.00 -1.16 -0.15 0.15

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Beduhn242

Data converted --> HDCS_Data in CARIS

Averages

Welton
Faulkes

all files

N/A

9435380.tid (Prelim)

NIDWT 2hrs

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Beduhn
Wartick

0.00 0.09 0.02 0.02

Resulting HVF File Name

MRU Align StdDev gyro 0.02 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets Values used through whole season

Name: Date:

Final Values based on

g
Standard Deviation

FINAL VALUES



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 2805
Date: 4/16/2013 Dn: 106
Personnel: SS Brooks, ENS Broo, ENS Chensue, ENS Marwine

PCS Serial #  IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) MV-320, VER4 (BD960)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 41 24

Lon 122 15 36

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency(kHz): 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.961 0.961

VDOP VDOP
1.425 1.425

Sattelites in use: 7 Sattelites in use: 7

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

NOAA POS/MV Calibration Report

3627 294

129.100.1.231

4851K33806

4851K33772

2013_106_2805.040
POSMV filename(s)

Lake Washington

Point Robinson 0927-9567-0001

Secondary GPS

N



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 19:40:00

End time: 20:09:05

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2013_04_16_POSCONFIG_GAMS.nvm

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None



COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config) Diagnostics

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



ERDDM Acquisition Log
Vessel

4/16/2013 106
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time
350 04 600
350 06 840
350 08 1310
170 010 1770
350 012 1900
170 014 2050

Processing Log

4/17/2013
Date Dn Personnel

Graph and Table Values compared with previous year

Launch 2805 200kHz

Lake Washington Partly Cloudy, Calm

SS Brooks, ENS Broo, ENS Chensue, ENS Marwine

N/A Please select DGPS Beacon
Tidal Cycle Notes

2013_106_2805.056 - .076
POSMV filename(s)

2013_106_2805.056 – 059 20:18:30 – 20:23:40
2013_106_2805.061 – 063 20:29:32 – 20:34:32
2013_106_2805.063 – 066 20:38:30 – 20:43:30
2013_106_2805.066 – 069 20:47:25 – 20:52:25
2013_106_2805.070 - 073 20:56:45 – 21:01:45
2013_106_2805.073 – 076 21:06:10 – 21:11:10

107 Bravo and Witmer

POS Files Processed in POS Pac Smartbase
Smartbase or Singlebase? Station used.

SBET Processed in Pydro Using the ERDDM Tool

Documentaion Complete in DAPR Appendix

See OPS/CST for updating HVF with new values



FA – 2805  

2013‐ DN106 

4th Order Ellipsoidally Referenced ERDDM 

 

 

 



 



Measuring Party:

Waterline measurements should be negative and cm!
Date: 4/3/2013
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0167 -0.0162

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.096

Individual 0.09735 0.09050
measurement 0.11635 0.09150
StDev for TPU xls 0.011 0.09935 0.08250
(of 6 #'s)

Measuring Party:

Date: 4/3/2013
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0133 -0.0195

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.142

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.15335 0.12850
measurement 0.15635 0.13150
StDev for TPU xls 0.012 0.14535 0.13650                       utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

0.151683333 0.132

Waterline measurements should be negative and cm!

0.00569 0.00404

1.07535 1.04250

-92.37 -91.03

-91.100

2805

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.088

-95.900

0.01044

-0.9710

-93.000

0.104

-90.600

-92.200 -91.400

1.04250

-95.100

-0.9543

-97.600

-97.10

0.00493

-0.9103

-91.900

-95.43

Beduhn, Golmon, Gluntz

-0.9237

101

32.3

-97.800 -95.200

Fill in Yellow squares only!

2805

Beduhn, Golmon, Gluntz

1.07535

Waterline Measurements

-96.000

2805
Port Benchmark to Waterline Stbd Benchmark to Waterline



2806 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 -0.013 0.624 n/a Scaler Distance 1.448 -0.637 -0.832 0.000 0.000
y 0.000 0.254 1.087 n/a -0.832 -0.637 0.000 0.000
z 0.000 0.481 3.602 -0.086 -3.121 -3.121 0.000 0.000

*IMU is Reference Point

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values. 2013

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.63695 RP to Waterline (m) IMU to x -0.63695 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83249 z 0.086 Port Ant (m) y -0.83249 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.12121 (calculated) z 3.12121 z 0.00000 z 0.00000

MBES RP x -0.01284 IMU to x -0.01284 IMU (m) x, y, z 0.00000 Top of x -0.63695 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.25447 Phase Ctr y 0.25447 Port Ant (m)  y -0.83249 (by design) y 0.00000
Center z -0.48083 (calculated) z -0.48083 Top of x 0.81062 z 3.14938 z 0.00000

Stbd Ant (m)  y -0.82526
z 3.10821 Base to top of Port Ant

(measured) (m)  z 0.074
Base to top of Stbd Ant
(measured) (m)  z 0.059 Bottom of Port Ant

(calculated) (m)  z 3.07521
Bottom of Stbd Ant
(calculated) (m)  z 3.04921 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.046
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.046

Coord. Sys.
NGS IMU to x -0.01284 x 0.62411 x n/a x -0.63695 x 0.00000

Phase Ctr y 0.25447 y 1.08696 y n/a Scalar Distance 1.4478 y -0.83249 y 0.00000
z -0.48083 z -3.60204 z 0.086 z 3.12121 z 0.00000

Coord. Sys. x -0.01284 Coord. Sys. x 0.62411 Coord. Sys. x n/a Coord. Sys. x -0.83249 Coord. Sys. x 0.00000
CARIS y 0.25447 CARIS y 1.08696 CARIS y n/a Pos/Mv y -0.63695 Pos/Mv y 0.00000

z 0.48083 z 3.60204 z -0.086 z -3.12121 z 0.00000

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



Description of Offsets for Launch 2806
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2806 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.448 m Primary Antenna Reference Pt.
7125 Phase Center

3.136 m

3.617 m

1 448 m

0.254 m

1.087 m

0.832m
Primary Antenna Reference Pt.

0.624 m
7125 to Port Ant.

IMU Reference Pt.

0.0128 m

IMU Reference Pt.

1.448 m

2806
LOA:    8.64m

0.481 m

0.013 m

7125 Phase Center

2806
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.624 m
7125 to Port Ant.

Beam:  3.48m
Draft:    1.12m

x y z x y z x y z x y z x y z
-0.013 0.254 0.481 0.624 1.087 3.602 n/a n/a -0.086 -0.637 -0.832 -3.121 0.000 0.000 0.000

IMU to Heave
Scalar Distance

1.448

IMU to 7125 Port Ant to 7125 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 

The values were calculated by 
subtracting the top of the Port
Antenna to the IMU x, y, z values 
then from the respective values of 
the IMU to the 7125.  The 
calculated values were then 
transposed from the NGS to the 

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
b bbl l l h l

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z-value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 

7125 to Port Ant.

the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

the IMU to the 7125.  The 
calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to 
get an average for the waterline 
to RP.  The Waterline 
Measurement value is in NGS 
coordinates initially and is 
converted to CARIS coordinates.

height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

center. Then the scalar distance 
between the phase centers was 
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NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2806.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny then cloudy with  temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica  TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
   
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 



NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr  p/n 39105-00) are to the top 
center of the antenna. To correct the Z value provided in this report for each antenna to 
the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2806 
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Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 



 
 

NOAA SURVEY VESSEL 2806 
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STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2806 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13142     -0.01122      -0.16986    IMUR  
Centerline Stern BM           -4.08215     0.02583    0.62671     CLS   
Centerline Bow BM    3.44035     0.02583    1.42590     BMB   
Portside GPS Ant. Ref. Point -0.83249     -0.63695   3.14938      GPSP  
Starboard GPS Ant. Ref. Point-0.82526   0.81062    3.10821       GPSS  
Multi-Beam Ref.Point    0.25447     -0.01284      -0.48083    MB    
Keel BM      0.44302     -0.02150      -0.61052    MBF   
Keel BM        -0.22767     -0.01641      -0.53926    MBA   
Port Side BM     0.08725     -1.41542   1.09615     BMP   
Starboard Side BM     0.09859    1.46945    1.01777       BMS   
Centerline Cab BM       -0.21255   0.06840    2.64944     BMC 
 
Units = meters 
 
 
 
      
      
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Appendix B  
 

Point to Point Inverse Launch 2806 
 

Pt. 1     Pt. 2   Dist.     Northing  Easting   Elevation  ID 
24        42      0.001    0.000    -0.001     0.00012    SBF  
 6        22      0.000    0.000      0.000     0.00025    SBA  
 7        23      0.001    0.001    -0.001     0.00048    SB  
33        35      0.004    0.003     0.001     0.00015    IMUR  
36        32      0.004    -0.002    -0.004     0.00010    IMU  
37        25      0.002    0.001      0.001     0.00013    CLS  
12        26      0.002    -0.001    -0.002     0.00054    BMS  
38        50      0.002    -0.002     0.000     0.00010    BMP  
52        20      0.006    0.006    -0.003     0.00045    BMB  
51        15      0.002    0.001     0.002     0.00011    BMC  
13        27      0.003    0.003    -0.001     0.00080    GPSS  
28        14      0.000    0.000     0.000     0.00023    GPSP 
 
Units = meters 
 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/7/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/7/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Launch 2806 200kHz

Marcus and Berube

250 Newport Turning Basin

250

Applanix POS/MV   S/N:2560    IMU S/N:991

yp pp p

Personnel on board

Comments

1832 9
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1909 8.3
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/33 124/02/28

Marcus and Berube

.554
POSMV Filename(s)

44/37/32 124/02/25



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 095 4.1
2 297 4.1
3 103 7.6
4 293 8.2
5 305 6.1
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 095 4.1
2 297 4.1
3 103 7.6
4 293 8.2
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 098 6.4
2 297 6.2
3 106 6.1
4 293 6.1
5

002_1844
002_1846

002_1841

XTF Line Filename
002_1838

XTF Line Filename
002_1838

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

001_1852

002_1841

004_1904

002_1844
002_1846

003_1848
XTF Line Filename

003_1850

001_1855

6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 120 6.1
2 299 5.9
3 004_1902 118 6.3
4
5
6
7
8

004_1900
004_1858

waked by another boat

XTF Line Filename



Processing Log
9/7/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1841&1846 0.00 1838&1841 -2.90 1900&1902 0.10 1850&1852
1841&1846 0.00 1838&1841 -2.43 1858&1900 0.11 1850&1852 1.30
1838&1844 0.00 1844&1846 -2.10 1900&1902 0.10 1850&1855 1.53
1841&1846 0.00 1844&1846 -2.40 1900&1902 0.06 1850&1852 1.33

crm

9435380.tid

2013_2806_250

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Froelich

Compute correctors in this order

250

Faulkes
Beduhn

Marcus, Berube

Evaluators

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS

0.00 -2.46 0.09 1.39
0.00 0.33 0.02 0.13
0.00 -2.46 0.09 1.39

MRU Align StdDev gyro 0.13 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.18 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 9/9/2013Ryan Wartick and ami Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/9/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/9/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

18:53 9.01
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/36.7 124/02/992013_252_18328

Launch 2806 400kHz

Froelich, Helmricks, Brooks

Froelich, Hemlricks

252

400 kHz

2013_252_2806

Newport,Or

CalmNewport, OR252

POSMV Filename(s)

Applanix POS/MV   S/N:XXXX    IMU S/N:XXX



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 289 3.9
2 289 6.0
3
4
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 289 6.0
2 109 6.4
3
4
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 109 6.0
2 289 5.7
3 289 6.0
4 289 5.9
5 109 5.9
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 289 6.0
2 109 6.4
3
4
5
6
7
8

2521918

XTF Line Filename
2521916

2521918
2521916

XTF Line Filename
2521922

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2521909

2521916

good line

off track due to traffic
little far out in the outer beams

good line
good line

2521914

2521903
XTF Line Filename

2521905

2521912

good line
XTF Line Filename

good line



Processing Log
9/8/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1922&1916 0.00 1916&1918 -1.50 1916&1918 -0.16 1912&1914 0.70
1916&1922 0.00 1916&1918 -1.40 1916&1918 -0.14 1909&1912 0.63
1916&1922 0.00 1916&1918 -1.20 1916&1918 -0.13 1909&1912 0.70
1916&1922 0.00 1916&1918 -1.57 1916&1918 -0.13 1909&1912 0.65

0.00 -1.42 -0.14 0.67
0.00 0.16 0.01 0.03
0.00 -1.42 -0.14 0.67

MRU Align StdDev gyro 0.03 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.09 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 9/10/2013Tami Beduhn and Ryan Wartick

zerotides

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Faulkes

Compute correctors in this order

252

Froelich
Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

wartick

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Fairweather Vessel: 2806
Date: 9/8/2013 Dn: 250
Personnel: Welton, Marcus

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat

Lon

DGPS B St ti DGPS R i S i l#

POSMV filename(s)

2560

287

5211K23462

129.100.1.231

5213K23675

NOAA POS/MV Calibration Report

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 287

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.706 0.979

VDOP VDOP
1.031 1.198

Sattelites in use: 17 Sattelites in use: 10

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 2.228 (Use View> GAMS Solution)

Secondary GPS

N

287



ERDDM Acquisition Log NO RESON MB LINES COL
Vessel

9/18/2013 261
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azimuth (°T) Vessel Speed RPM Start and End Time  (UTC)
N/A DIW N/A
250 clutch/ 4 kts 600 in Trawl
250 6 kts 770
250 8 kts 1160
250 10 kts 1520

N/A DIW N/A
070 clutch/ 4 kts 600 in Trawl

Tidal Cycle Notes

2013_261_2806b.791 - .798
POSMV filename(s)

1650 - 1656

Launch 2806 400kHz

.791 - .792

TRIM TABS ALL THE WAY UP; NO MB LINES COLLECTED

SS Brooks, LT Wartick, ENS Witmer

PC/ High 78°F

Point Loma, CA - 302 kHz (100 B5.72 ft High @ 0910 (PDT); 0.47 ft Low @ 1511 (PDT)

LA/LB/San Pedro Bay

1656 - 1700

794 - 795

1701 - 1705
1705 - 1709  (waked @ 1708)
1709 - 1713

1713 - 1719
1719 - 1723 (waked @ 1723)

2013_261_2806b.791 - .791

.792 - .793

.793 - .793

.793 - .794

.794 - .794
070 clutch/ 4 kts 600 in Trawl
070 6 kts 770
070 8 kts 1160
070 10 kts 1520

N/A DIW N/A.797 - .797

1731 - 1735

1735 - 1741

1723 - 1727 (waked @ 1723)
1727 - 1731 

.794 - .795

.795 - .795

.795 - .796

.796 - .797

1719 - 1723 (waked @ 1723)



Processing Log

10/19/2013
Date Dn Personnel

Graph and Table Values compared with previous year

See OPS/CST for updating HVF with new values

Documentaion Complete in DAPR Appendix

262 Josh Witmer

SBET Processed in Pydro Using the ERDDM Tool

POS Files Processed in POS Pac Singlebase
Smartbase or Singlebase? Station used.



FA – 2806  

2013‐ DN261 

4th Order Ellipsoidally Referenced ERDDM

 

 



 

 
 

 



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!
Date: 4/5/2011
Fuel Level: 41.3 gallons

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0784 -0.0147 -0.0930

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.086 NGS Coordinate System (do not enter in CARIS directly)

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.12415 0.03277
measurement 0.13415 0.03777
StDev for TPU xls 0.051364 0.13815 0.04677   utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

Measuring Party:

Date: 4/26/2011
Fuel Level: 110 gallons

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0784 -0.0333 -0.1117

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.101 NGS Coordinate System (do not enter in CARIS directly)

Individual 0.16515 0.03377
measurement 0.14615 0.04177
StDev for TPU xls 0.06207 0.15915 0.05977
(of 6 #'s)

1.01777

2806
Port Benchmark to Waterline

-95.0

2806

ST Francksen, AST Mallory, ENS Smith

ENS Pfundt, AST Mallory, ENS Smith

Waterline Measurements

-0.9393

0.00721 0.00709

-0.9727

1.09615
0.132

2806

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.039

-96.2 -98.0

Stbd Benchmark to Waterline

-97.2 -98.5

-97.1-95.8

-96.40

-0.9640

0.156816667 0.045

Waterline measurements should be negative and cm!

0.00971 0.01332

-93.7 -95.8

1.09615 1.01777

-93.93 -97.27

-97.6

-97.87

-0.9787

-93.1 -98.4



  2807 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.019 0.804 n/a Scaler Distance 1.440 -0.786 -0.812 0.000 0.000
y 0.000 0.244 1.056 n/a -0.812 -0.786 0.000 0.000
z 0.000 0.481 3.628 -0.090 -3.147 -3.147 0.000 0.000

*IMU is Reference Point

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.78576 RP to Waterline (m) IMU to x -0.78576 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.81181 z 0.090 Port Ant (m) y -0.81181 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.14689 (calculated) z 3.14689 z 0.00000 z 0.00000

MBES RP x 0.01867 IMU to x 0.01867 IMU (m) x, y, z 0.00000 Top of x -0.78576 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24441 Phase Ctr y 0.24441 Port Ant (m)  y -0.81181 (by design) y 0.00000
Center z -0.48063 (calculated) z -0.48063 Top of x 0.65423 z 3.13559 z 0.00000

Stbd Ant (m)  y -0.81691
z 3.16283 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.06259
Bottom of Stbd Ant
(calculated) (m)  z 3.08983 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.01867 x 0.80443 x n/a x -0.78576 x 0.00000

Phase Ctr y 0.24441 y 1.05622 y n/a Scalar Distance 1.4403 y -0.81181 y 0.00000
z -0.48063 z -3.62752 z 0.090 z 3.14689 z 0.00000

Coord. Sys. x 0.01867 Coord. Sys. x 0.80443 Coord. Sys. x n/a Coord. Sys. x -0.81181 Coord. Sys. x 0.00000
CARIS y 0.24441 CARIS y 1.05622 CARIS y n/a Pos/Mv y -0.78576 Pos/Mv y 0.00000

z 0.48063 z 3.62752 z -0.090 z -3.14689 z 0.00000

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



Description of Offsets for Launch 2807
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2807 was based from IMU Reference Point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.440 m Primary Antenna Reference Pt.

3.147 m

3.628 m

7125 Phase Center

1.056 m

0.812 m
Primary Antenna Reference Pt.

0.804 m
7125 t P t A t

IMU Reference Pt.

0.0187 m

1.440 m

0.244 m
7125 to Port Ant.

0.481 m

0.019 m

7125 Phase Center

2807
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.80443 m
7125 t P t A t

IMU Reference Pt.

2807
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

x y z x y z x y z x y z x y z
0.019 0.244 0.481 0.804 1.056 3.628 N/A N/A -0.090 -0.786 -0.812 -3.147 0.000 0.000 0.000

IMU to Port Antenna IMU to Heave
Scalar Distance

1.440

IMU to 7125 Port Ant to 7125 RP to Waterline Port Ant to Stbd Ant

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 

The values were calculated by 
subtracting the physical height  of 
the Port Antenna to the IMU x, y, z 
values from the respective values of 
the IMU to the 7125. The 

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using 

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the 
h i ht f th t d th

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 

t Th th l di t

0.80443 m
7125 to Port Ant.

the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

the Port Antenna to the IMU x, y, z 
values from the respective values of 
the IMU to the 7125. The 
calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined with
the Z value of the Benchmarks to 
the RP/IMU to get an average for 
the waterline to RP.  The 
Waterline Measurement value is 
in NGS coordinates initially and is 
converted to CARIS coordinates.

value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

coordinate system. 
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NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2807.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy early then sunny  with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001 m 
and a vertical accuracy of 0.000 m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2807 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13111    0.00714    -0.16724    IMUR  
Centerline Stern BM          -4.06155      -0.02156   0.64902     CLS   
Centerline Bow BM    3.44775    -0.02156   1.41160     BMB   
Portside GPS Ant. Ref. Point -0.81181   -0.78576   3.13559     GPSP  
Starboard GPS Ant. Ref. Point-0.81691   0.65423    3.16283     GPSS  
Multi-Beam Ref.Point    0.24441    0.01867      -0.48063    MB    
Keel BM      0.43114    0.01129    -0.61049    MBF   
Keel BM        -0.23560   0.00988    -0.53203    MBA   
Port Side BM     0.09979    -1.46918   1.03292     BMP   
Starboard Side BM     0.08626    1.42671    1.08830     BMS   
Centerline Cab BM       -0.21841   -0.05358   2.65245     BMC 
 
Units = meters 
   
 
 
           
   
      
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Appendix B  
 

Point to Point Inverse Launch 2807 
 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18   37     0.002    -0.002     0.000     0.00024    MBF 
35   39     0.001    -0.001    -0.001     0.00027    MBA 
19   36     0.004     0.001     0.004     0.00043    MB 
29   27     0.006     0.001     0.006     0.00023    IMUR 
26   30     0.006     0.005     0.004     0.00012    IMU 
20   31     0.001    -0.001    -0.001     0.00038    CLS 
32   45     0.000     0.000     0.000     0.00005    BMP 
21    9     0.000     0.000     0.000     0.00057    BMS 
49   16     0.007     0.007     0.000     0.00076    BMB 
12   46     0.001    -0.001     0.000     0.00044    BMC 
11   47     0.003    -0.002     0.001     0.00094    GPSP 
10   48     0.002    -0.002     0.001     0.00068    GPSS 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/17/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/17/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

33/43/25.34N 118/12/35.88W2013_260_163209

Launch 2807 200kHz

Marcus,Bradley, Glunz

marcus,bradley

260

7125- 400khz

2013_260_2807.074-090

1812027

LA

Calm, minimal windLA

18m

260

POSMV Filename(s)

Applanix POS/MV   S/N:3628    IMU S/N:037

2013_260_182752 33/43/20.96N 118/12/50.11W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 065 4.0
2 066 4.0
3 064 4.0
4 065 8.0
5 065 8.0
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 246 4.0
2 065 4.0
3 250 4.0
4 064 4.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 245 5.0
2 060 5.0
3 246 5.0
4 064 5.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 252 5.0
2 068 5.0
3 248 5.0
4 070 5.0
5
6
7
8

28072013M_2601757
28072013M_2601759

28072013M_2601755

XTF Line Filename
28072013M_2601753

don't use

28072013M_2601818
28072013M_2601815

XTF Line Filename
28072013M_2601739

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

28072013M_2601811

2nd best line
best line

28072013M_2601742

28072013M_2601750

28072013M_2601745
28072013M_2601748

20m
20m

15m
15m

28072013M_2601808
XTF Line Filename

28072013M_2601809

28072013M_2601813

XTF Line Filename

28072013M_2601820
28072013M_2601822



Processing Log
9/17/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1745&1748 0.00 1753&1755 -2.70 1815&1818 0.16 1808&1809 0.33
1745 & 1748 0.00 1757 & 1759 -2.80 1815 & 1818 0.15 1808 & 1809 0.80
1745 & 1748 0.00 1757 & 1759 -2.78 1815 & 1818 0.15 1808 & 1809 0.70
1745 & 1748 0.00 1757 & 1759 -2.75 1815 & 1818 0.15 1808 & 1809 0.80

0.00 -2.76 0.15 0.66
0.00 0.04 0.01 0.22
0.00 -2.76 0.15 0.66

MRU Align StdDev gyro 0.22 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 9/25/2013Tami Beduhn

L318FA2013CORP_Rev.zdf

Fill's used from LA Project

Nearest with in Distance with in Time 4 Hrs

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Froelich

Compute correctors in this order

Used Average Values

260

Smith
Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Helmricks, Beduhn

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/17/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/17/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2013_260_182752 33/43/20.96N 118/12/50.11W

Launch 2807 400kHz

Marcus,Bradley, Glunz

marcus,bradley

260

7125- 400khz

2013_260_2807.074

1812027

LA

Calm, minimal windLA

18m

260

POSMV Filename(s)

Applanix POS/MV   S/N:3628    IMU S/N:XXX

33/43/25.34N 118/12/35.88W2013_260_163209



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1
2
3
4
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (m/s) Remarks

1 240 4.0
2 240 2.0
3 240 4.0
4 060 2.0
5 240 2.0
6 060 2.0
7 240 2.0
8 240 2.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 240 2.0
2 060 2.0
3
4
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 065 2.3
2 246 2.3
3
4
5
6
7
8

XTF Line Filename

1722
XTF Line Filename

1720

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

1702
1644

1658

1653
1656

1700

1651

XTF Line Filename
1649

1726
1724

XTF Line Filename



Processing Log
9/17/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1651&1653 0.00 1656&1658 -2.60 1724&1726 0.15 1722&1720 0.35
1649 &1651 0.00 1656 &1658 -2.61 1724 & 1726 0.19 1720 & 1722 0.20
1649 &1651 0.00 1656 &1658 -2.60 1724 & 1726 0.17 1720 & 1722 0.25
1649 &1651 0.00 1656 &1658 -2.50 1724 & 1726 0.15 1720 & 1722 0.23

0.00 -2.58 0.17 0.26
0.00 0.05 0.02 0.07
0.00 -2.58 0.17 0.26

MRU Align StdDev gyro 0.07 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.04 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 9/25/2013

Data converted --> HDCS_Data in CARIS

260

Smith
Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Helmricks, Beduhn

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Tami Beduhn

L318FA2013CORP_Rev.zdf

Fill's used from LA Project

Nearest with in Distance with in Time 4 Hrs

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Froelich



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Fairweather Vessel: 2807
Date: 9/16/2013 Dn: 259
Personnel: Wartick, Madsen, Glunz

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 33 43 22.92n

Lon 118 2 40.70w

DGPS B St ti DGPS R i S i l#

POSMV filename(s)

3628

P i t L CD P004420

5044K18796

129.100.1.231

4904K34026

NOAA POS/MV Calibration Report

LA

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.625 0.627

VDOP VDOP
0.937 0.95

Sattelites in use: 17 Sattelites in use: 17

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.532 (Use View> GAMS Solution)

Secondary GPS

N

Point Loma CD P004420



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)



Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

NoneNone

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None



COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Processing Log

Date Dn Personnel

See FOO/CST with values

Values

Allow decimeter level freedom when processingPOS Pac Processing

Reprocess using new values, but restrict to 10 cm of freedom

Reprocess using new values, again use 10 cm of freedom

Continue itterating until values no longer change

Final Antena Seperation/ Lever Arms Determined

Post Processing of GAMS Calibration

New Values entered in POS View?



ERDDM Acquisition Log
Vessel

9/3/2013 246
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time
122 04 600
298 05 600
121 05 800
295 06 800
121 06 1000
298 07 1000
115 07 1200
298 07 1200

Newport, OR

1957-2000
2001-2004

1944-1947
19:39-1942

1948-1951
.

2005-2008
2009-2012

Launch 2807 400kHz

1952-1955

Furguson, Welton, Berube

Sunny, Partly Cloudy

Please select DGPS BeaconSlack
Tidal Cycle Notes

2013_246_2807_ERDDM.000
POSMV filename(s)

298 07 1200
119 08 1400
300 09 1400
125 09 1600
296 010 1600

0 0

2012-2015
2009-2012

2016-2019

2032-2037, engaged gear due to drift

2019-2022
2023-2026



Processing Log

9/5/2013
Date Dn Personnel

Graph and Table Values compared with previous year

POS Files Processed in POS Pac Singlebase
Smartbase or Singlebase? Station used.

248 Witmer

SBET Processed in Pydro Using the ERDDM Tool

See OPS/CST for updating HVF with new values

Documentaion Complete in DAPR Appendix



FA – 2807  

2013‐ DN246 

4th Order Ellipsoidally Referenced ERDDM 

 

 



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!
Date: 4/6/2011
Fuel Level: 21 US Gal 

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) -0.0554 0.0157 0.0710

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.090 NGS Coordinate System (do not enter into CARIS directly)

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.06792 0.09130
measurement 0.04792 0.14330
StDev for TPU xls 0.043882 0.04892 0.14330   utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

1.08830

2807

Waterline Measurements

0.01127 0.03002

1.03292
0.055

2807

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.126

-98.5 -94.5

-96.5 -99.7

-94.5-98.4

-97.80

-0.9780

-96.23

-0.9623



  2808 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.685 n/a Scaler Distance 1.453 -0.682 -0.837 0.000 0.000
y 0.000 0.250 1.086 n/a -0.837 -0.682 0.000 0.000
z 0.000 0.477 3.637 -0.093 -3.160 -3.160 0.000 0.000

*IMU is Reference Point -0.123

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68151 RP to Waterline (m) IMU to x -0.68151 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83666 z 0.093 Port Ant (m) y -0.83666 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.15974 (calculated) z 3.15974 z 0.00000 z 0.00000

MBES RP x 0.00351 IMU to x 0.00351 IMU (m) x, y, z 0.00000 Top of x -0.68151 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.24969 Phase Ctr y 0.24969 2010 RP to Waterline (m) Port Ant (m)  y -0.83666 (by design) y 0.00000
Center z -0.47677 (calculated) z -0.47677 z 0.123 Top of x 0.77098 z 3.14844 z 0.00000

Stbd Ant (m)  y -0.83402
z 3.13235 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.07544
Bottom of Stbd Ant
(calculated) (m)  z 3.05935 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.00351 x 0.68502 x n/a x -0.68151 x 0.00000

Phase Ctr y 0.24969 y 1.08635 y n/a Scalar Distance 1.4526 y -0.83666 y 0.00000
z -0.47677 z -3.63651 z 0.093 z 3.15974 z 0.00000

Coord. Sys. x 0.00351 Coord. Sys. x 0.68502 Coord. Sys. x n/a Coord. Sys. x -0.83666 Coord. Sys. x 0.00000
CARIS y 0.24969 CARIS y 1.08635 CARIS y n/a Pos/Mv y -0.68151 Pos/Mv y 0.00000

z 0.47677 z 3.63651 z -0.093 z -3.15974 z 0.00000

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)



Description of Offsets for Launch 2808
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2808 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.4526 m Primary Antenna Reference Pt.

0.24969 m

7125 Phase Center

1.086 m

0.837 m
Primary Antenna Reference Pt.

0.685 m
7125 to Port Ant.

0 790

K5K Reference Pt.

3.15974 m

3 63651 m

0.004 m

IMU Reference Pt.

1.453 m

0.790 m
-0.564 m

3.63651 m

IMU Reference Pt
2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.47677 m

0.00351 m

7125 Phase Center

IMU Reference Pt.

2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 68502 m

x y z x y z x y z x y z x y z
0.004 0.250 0.477 0.685 1.086 3.637 n/a n/a -0.093 -0.682 -0.837 -3.160 0.000 0.000 0.000

IMU to K5K

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
Scalar Distance

1.453

IMU to 7125 Port Ant to 7125 RP to Waterline

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 

t t k hil

The values were calculated by 
subtracting the physical height of 
the of the Port Antenna to the 
IMU x, y, z values from the 
respective values of the IMU to

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase

0.68502 m
7125 to Port Ant.

x y z
-0.564 0.790 0.777

IMU to K5K

the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

e o e o e a o e
IMU x, y, z values from the 
respective values of the IMU to 
the 7125.  The calculated values 
were then transposed from the 
NGS to the CARIS coordinate 
system.

a d e S a boa d e c a o
the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined 
with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to 
CARIS coordinates.

value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
level.

y using a steel tape and bubble 
level.
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2808 TILTED TRANSDUCER HEAD MULTIBEAM ACQUISITION  
SYSTEM READINESS REPORT 

 
 
Vessel:   2808  
Sonar:  Reson 8125 MBES 
Written By:   LT Jaskoski 
Report Date:  21-SEP-2010 
 
Background:  
During the 2010 field season, a RESON 8125 MBES was mounted on a variable angle 
adjustable sled mount at an angle of 25° to STBD.  After the installation Fairweather 
personnel measured the offsets from reference points on the transducer to a reference 
point on the launch.  Additionally, Fairweather personnel calculated the offsets from the 
transducer reference points to the acoustic center of the transducer thereby tying in the 
acoustic center to the IMU reference frame.  The tabulated values below are in the NGS 
coordinate system (X=+STBD, Y=+Fwd, Z=+up) see figure 1. 

 
Figure 1. NGS Coordinate system. 
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Calibration Location, Date, and Personnel:  
 
Personnel: LT Jaskoski 
Coxswain: N/A 
Location: Kodiak, AK 
Date: 20-SEP-2010; DN 263 

 
Procedure for measurement of offsets: 
A benchmark located on the keel of the vessel forward of the Reson 7125sv transducer 
well was surveyed by NGS to be at a position offset from the IMU reference point at the 
position; x = -0.00126m, y = 0.44021m and z = -0.60545m.  From this benchmark 
measurements were made to two reference points on the Reson 8125 transducer; x and z 
measurements were taken to a marked reference point at the base of the projector (figure 
2), y measurements were taken to the after facing surface of the receiver array housing 
(figure 2).  Offsets to the acoustic center of the Reson 8125 were calculated using system 
specific values detailed in the Reson 8125 operators manual v4.01 (March, 2004).  From 
the operators manual an offset of 0.121m to the acoustic center was applied to the 
measured y offset value in the aft direction (-Y) from the after facing surface of the 
receiver array housing.  The acoustic center is also offset orthogonally from the projector 
by 0.03475m down (-Z) direction when the transducer is in an un-tilted configuration.  
The x and z components of the acoustic center offset in the 25° tilted configuration were 
accounted for trigonometrically using the following formulae: x = 0.03475sin25° and z = 
-0.03475cos25°.  This yielded offset of x = 0.01469m and z = -0.03149m (figure 2) from 
the reference point to the acoustic center.  These offsets were then applied to the 
measured offsets.   

 
 
Figure 2: Calculated X, Y, and Z offsets from the Reson 8125 reference point for X and Z 
(base of projector), and for Y (aft face of receive array housing) to the Reson 8125 
acoustic center.   
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Result: 
The surveyed offsets from the IMU reference point to the keel benchmark are: 
X = -0.00126m 
Y = 0.44021m 
Z = -0.60545m 
 
The measured offset from the keel benchmark the Reson 8125 reference points are: 
X = 0.639m 
Y = 0.212m 
Z = -0.076m 
 
The calculated offset from the Reson 8125 reference points to the Reson 8125 acoustic 
center are: 
X = 0.01469m 
Y = -0.1210m 
Z = -0.03149m 
 
The resultant offsets from the IMU to the Reson 8125 acoustic center are: 
X=0.652m 
Y=0.531m 
Z= -0.713m  
 
Or in the Caris coordinate System:  
X= 0.652m 
Y= 0.531m 
Z= 0.713m  
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Figure 3: Vessel X and Z offsets from the Reson 8125 acoustic center to IMU reference 
point and to the Primary Antenna reference point.  
 
 

 
 
 

 
Figure 4: Vessel X and Y offsets from the Reson 8125 acoustic center to IMU reference 
point and to the Primary antenna reference point.    
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When changing the sonar head to a tilt or back to normal there are three (3) places the 
offset is located that needs to be changed.   

1.  Reson Sonar Display  –   MENU: Filters head tilt (- 30˚ / 5˚ / 0˚) STBD is 
negative, PORT is positive 

  
2. Hysweep Hardware  – Reson Seabat 81XX  –  Go to the Offsets Tab 

 
** Place the sonars tilt in Roll (this will ensure a proper matrix is displayed)** 
 

3. Caris HVF    –    SVP1 tab 
– Roll (deg) - place the sonar tilt here. (reminder: + to Port, – to 

Stbd) 

 
 



NOAA SHIP Fairweather (S220) 
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Recommendations 
It is the recommendation that the resultant offsets from the IMU to the Reson 8125 
acoustic center of: X=0.652m, Y=0.531m, Z= 0.713m be applied to the CARIS vessel 
configuration file.   
 
The angle of tilt (25° STBD up) should be applied in three separate places:  

1) In the Reson sonar display under the filters menu, the “head tilt” should be set to: 
-25° 
 

2) In Hypack Hyseep hardware setup, under the offsets tab for the Reson 8125 the 
rotational offset “Roll” should be set to:  
-25° 
 

3)  In the CARIS *.hvf under the SVP1 tab the “Roll (deg)” should be set to: 
-25° 
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NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2808.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy then sunny with temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2808 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13282    -0.00186   -0.16518    IMUR  
Centerline Stern BM          -4.07730   0.01391    0.61506     CLS   
Centerline Bow BM    3.44544    0.01391    1.44047     BMB   
Portside GPS Ant. Ref. Point -0.83666   -0.68151   3.14844     GPSP  
Starboard GPS Ant. Ref. Point-0.83402   0.77098    3.13235     GPSS  
Multi-Beam Ref.Point    0.24969    0.00351    -0.47677    MB    
Keel BM      0.44021    -0.00126   -0.60545    MBF   
Keel BM        -0.22600   0.00192    -0.53583    MBA   
Port Side BM     0.08204    -1.42963   1.07600     BMP   
Starboard Side BM     0.08324    1.46250    1.04444     BMS   
 
Units = meters 
   
 
       
    
      
   
  
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Appendix B  

 
Point to Point Inverse Launch 2808 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
3    40   0.001   -0.001    0.000    0.00026    MBF 
5    42   0.003   -0.002   -0.001    0.00013    MBA 
4    41   0.002   -0.001   -0.002    0.00062    MB 
14   55   0.006   -0.005    0.004    0.00049    IMUR 
13   56   0.006   -0.004    0.004    0.00055    IMU 
43    6   0.001    0.000    0.001    0.00048    CLS 
33   44   0.000    0.000    0.000    0.00006    BMS 
8    22   0.001   -0.001    0.000    0.00039    BMP 
17   25   0.005    0.000    0.005    0.00011    BMB 
24   34   0.001    0.000    0.000    0.00049    GPSS 
23    7   0.000    0.000    0.000    0.00022    GPSP 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/24/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/24/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1630 ~34
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

Roll Stabilization on, Used Datagram 2

2013_114_2808.308-
POSMV Filename(s)

47/40/37.9791 122/25/14.2623

114 Shilshole calm, sunny

80 meters

Zacharias, Bradley, Ferguson

182020

Applanix POS/MV   S/N:2560       IMU S/N:354

Launch 2808 200kHz

114 Shilshole

Zacharias, Bradley, Ferguson

Reson 7125



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

240 7.0
066 6.0

2808_200_003_1710.RAW 238 4.5-5
2808_200_003_1713.RAW 058 4.5

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 6.5
115 6-6.5

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

313 6.5/7.5
135 6.5/7.5
313 6.5/7.5
135 6.5/7.5
313 6.5/7.5
135 6.5/7.5
313 5-6
135 5-6
313 5-6
135 5-6
313 5-6
135 5-6

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

240 7.0
066 6.0

2808_200_003_1710.RAW 238 4.5-5
2808_200_003_1713.RAW 058 4.5

2808_200_003_1707.RAW noisy

2808_200_001_1737
2808_200_002_1739
2808_200_001_1740

XTF Line Filename
2808_200_003_1704.RAW Roll Stab is on

2808_200_011_1647 noisy
2808_200_011_1733
2808_200_17_34_23
2808_200_013_1736

2808_200_013_1642 noisy
2808_200_012_1644 noisy
2808_200_002_1645 noisy

XTF Line Filename
2808_200_011_1640 noisy
2808_200_001_1641 noisy

XTF Line Filename
2808_200_10_1649
2808_200_10_1650

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename
2808_200_003_1704.RAW
2808_200_003_1707.RAW noisy



Processing Log
4/26/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.96 0.28 -0.17

1704 & 171 0.00 1640 &1647 -0.99 1710 & 1713 0.33 1740 &1739 -0.20
1701&1710 0.00 1649&1650 -0.73 1710&1713 0.33 1740&1734 -0.20
3_1701, 3_ 0.00 10_1649, 10_-0.80 3_1710, 3_170.33 1_1740, 2_17-0.18

0.00 -0.87 0.32 -0.19
0.00 0.12 0.02 0.02
0.00 -0.87 0.32 -0.19

MRU Align StdDev gyro 0.02 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/14/2013

Resulting HVF File Name

Tami Beduhn

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Beduhn
Zacharias
TMS

N395FA2010CORP.zdf

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Wozumi

Data converted --> HDCS_Data in CARIS

TrueHeave applied 2013_114_2808_Concat.000

SVP applied 2013_114_2808_concat.svp

Tide applied 9447130.tid  (got an error that tide data out of range)

116 Zacharias



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/28/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/28/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1724 14.92
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1828 14.14
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

33/43/19.17N 118/12/47.81W2013_271_172415.

Launch 2808 200kHz

marcus,berube,dodge,ferguson

marcus,berube

271

RESON 7125

2013_271_2808.241-301 POS files located in H12618 Dn271 folder

LA/LB

mud

clear, calmla/lb

15m

271

POSMV Filename(s)

Applanix POS/MV   S/N:3627    IMU S/N:XXX

2013_271_182826 33/43/25.61N 118/12/32.05W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 067 4.3
2 070 8.1
3 068 4.3
4 069 8.3
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 250 4.4
2 063 4.3
3 251 4.1
4 070 4.3
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 245 5.3
2 069 5.2
3 248 5.1
4 068 5.7
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 244 4.3
2 069 4.5
3 245 4.3
4 063 4.3
5
6
7
8

2013M_2711753
2013M_2711756

2013M_2711750

XTF Line Filename
2013M_2711747

2013M_2711814
2013M_2711809

XTF Line Filename
2013M_2711732

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2013M_2711804

2013M_2711736
2013M_2711740
2013M_2711744

20m
20m

2013M_2711818

20m
20m

2013M_2711759
XTF Line Filename

2013M_2711801

2013M_2711806

XTF Line Filename

2013M_2711822



Processing Log
9/29/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1732&1736 0.00 1750&1753 -2.70 1809&1814 0.30 1804&1806 0.35
1732&1736 0.00 1750&1753 -2.85 1809&1814 0.28 1804&1806 0.52
1732&1736 0.00 1750&1753 -2.70 1809&1814 0.32 1804&1806 0.32
1732&1736 0.00 1747&1750 -2.78 1809&1814 0.31 1804&1806 0.32

0.00 -2.76 0.30 0.38
0.00 0.07 0.02 0.10
0.00 -2.76 0.30 0.38

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.04 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/3/2014Tami Beduhn

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Beduhn

Compute correctors in this order

271

Marcus
Francksen

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Francksen

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/24/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/24/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1900 100m
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

Roll Stabilization on, Used Datagram 2

POSMV Filename(s)

47/40/29.0347 122/25/25.3342

114 Shilshole Sunny, Calm

Zacharias, Bradley, Ferguson

Applanix POS/MV   S/N:XXX       IMU S/N:XXX

Launch 2808 400kHz

114 Shilshole

Zacharias, Bradley, Ferguson

Reson 7125



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

240 5.0
240 6.5

003_1834_.RAW 060 6.0
003_1840_.RAW 060 4.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 6.5
110 6.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

315 6.0
130 6.0
315 6.0
115 6.0
315 6.5
130 6.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

240 5.0
240 6.5

003_1834_.RAW 060 6.0
003_1840_.RAW 060 4.0

XTF Line Filename
003_1824_.RAW
003_1831.Raw

011_1808

002_1805
012_1806
013_1807

XTF Line Filename
011_1802
001_1803

XTF Line Filename
010_1810
010_1811

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename
003_1824_.RAW
003_1831.Raw



Processing Log
4/26/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
3_1834, 3_ 0.00 10_1810, 10_-0.73 3_1831, 3_180.33 2_1805, 12_10.44

-0.01 0.33
1824&1831 0.00 1810&1811 -0.80 1831&1834 0.30 1803&1807 0.52
1824&1831 0.00 1802&1808 -0.82 1831&1834 0.29 1803 & 1805 0.33

0.00 -0.78 0.31 0.43
0.01 0.05 0.02 0.09
0.00 -0.78 0.31 0.43

MRU Align StdDev gyro 0.09 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/14/2013Tami Beduhn

Standard Deviation
FINAL VALUES

Final Values based on

Resulting HVF File Name

Beduhn

Averages

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

TMS
Wozumi
Zacharias

SVP applied 2013_114_2808_concat.svp

Tide applied 9447130.tid  (got an error that tide data out of range)

N395FA2010CORP.zdf

Compute correctors in this order

116 Zacharias

Data converted --> HDCS_Data in CARIS

TrueHeave applied 2013_114_2808_Concat.000



FAIRWEATHER
Multibeam Echosounder Calibration Launch 2808 8125

Vessel

9/23/2010
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/23/2010
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

266

flat and rky

C b ll M B k

Campbell

unknownLaunch 2808 8125

266

Reson 8125

315624400007

3/4/10

South Chatham Strait

9/20/10Tilted Head, hull mount attachment

POS/MV 320 v4

Overcast, breezy, 1-2 ft. chopSouth Chatham Strait

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

134/15/39.5W56/22/40.7Nship process #1

2010-266-2805

Campbell, Morgan, Brooks



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
#1 257 ~4 kts

1 085 ~4 kts
1 257 ~4 kts
1 085 ~4 kts
1 190 ~4 kts
1 348 ~4.5 kts

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
#1 257 4kts

079 5 kts
257 4 kts
079 4.7 kts
180 4.0
353 4 0

2661738

2661809

2661735

2661757
2661759
2661803
2661807

2661754

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename

XTF Line Filename

XTF Line Filename
2661723
2661726
2661728
2661732

353 4.0
180 4.0
353 4.5

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
#1 062 4.0

242 3.9
035 3.0
205 3.8
033 4.5
223 4.0

2661815

2661809

2661918

2661812

XTF Line Filename

2661921

2661818
2661821
2661912
2661915



Processing Log
9/24/2010
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.61 0.60 0.65

-1.41 0.57 0.45
-0.97 0.53 0.83

0.00 -1.00 0.56 0.50

bcc

O322FA2010CORP.zdf

H12064_2808_Patch, bcc

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Campbell
Welton
Jaskoski
Morgan

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Campbell267

0.00 -1.00 0.57 0.61
0.00 0.33 0.03 0.17
0.00 -1.00 0.57 0.61

Resulting HVF File Name

MRU Align StdDev gyro 0.17 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.18 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 10/8/10CST Morgan

Final Values based on

Averages
Standard Deviation

FINAL VALUES

FA_2808_Rsn8125_TiltedHead_2010.hvf

Averages



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 2808
Date: 4/16/2013 Dn: 106
Personnel: ENS Marwine ENS Broo ENS Chensue SS Brooks

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) MV-320, Ver4 (BD960)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 41 38.4871

Lon 122 15 34.2194

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 323khz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.593 0.593

VDOP VDOP
1.05 1.049

Sattelites in use: 9 Sattelites in use: 9

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 2.305 (Use View> GAMS Solution)

N

POSMV filename(s)

Lake Washington

Robinson Pt.

Secondary GPS

NOAA POS/MV Calibration Report

3627 324

129.100.1.231



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 15:38:16

End time: 16:41:50

Heading accuracy achieved for calibration: 0.025

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None



COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



ERDDM Acquisition Log
Vessel

4/16/2013 106
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azimuth Vessel Speed (k RPM Start and End Time (UTC)
350 4.1 600
350 6.0 890
350 8.0 1360
170 10.0 1740
350 12.0 1890
170 14.0 2000

Processing Log

4/17/2013
Date Dn Personnel

Graph and Table Values compared with previous year

POS Files Processed in POS Pac Smartbase
Smartbase or Singlebase? Station used.

SBET Processed in Pydro Using the ERDDM Tool

Documentaion Complete in DAPR Appendix

See OPS/CST for updating HVF with new values

107 Bravo and Witmer

2013_106_2808.070-071 17:39:55 – 17:45:30

2013_106_2808.065-066 17:06:58 – 17:12:00
2013_106_2808.066-067 17:17:10 – 17:22:20
2013_106_2808.068-069 17:29:20 – 17:33:47

Tidal Cycle Notes

2013_106_2808.059 to .xxx
POSMV filename(s)

2013_106_2808.061-062 16:47:15 – 16:51:44
2013_106_2808.063-064 16:55:42 – 17:00:58

Launch 2808 400kHz

Lake Washington clear, calm

Brooks, Broo, Chensue, Marwine

No multibeam.

no tides Robinson Point, WA - 323 kHz (200 BPS)



FA – 2808  

2013‐ DN106 

4th Order Ellipsoidally Referenced ERDDM 

 

 



 



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!
Date: 3/14/2011
Fuel Level: 62.6 GAL (about 1/2 full)

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0240 -0.0556

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.093 NGS Coordinate System (do not enter into CARIS directly)

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.13300 0.06144
measurement 0.11800 0.07344
StDev for TPU xls 0.032 0.11100 0.06044   utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

Measuring Party:

Date: 3/21/2011
Fuel Level: 100gal

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0257 -0.0572

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.106 NGS Coordinate System (do not enter into CARIS directly)

(or add this value to VSSL_Offsets & Measurements_20XX)
Individual 0.11400 0.07344
measurement 0.15500 0.08344
StDev for TPU xls 0.034079 0.13600 0.07644
(of 6 #'s)

1.04444

2808
Port Benchmark to Waterline

-92.1

2808

Francksen, Stuart, Pfundt, Smith

Francksen, Pfundt, Abraham

Waterline Measurements

-0.9410

0.01124 0.00723

-0.9667

1.07600
0.121

2808

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.065

-95.8 -97.1

Stbd Benchmark to Waterline

-94.3 -98.3

-98.4-96.5

-95.53

-0.9553

0.135 0.078

Waterline measurements should be negative and cm!

0.02052 0.00513

-94.0 -96.8

1.07600 1.04444

-94.10 -96.67

-96.1

-97.93

-0.9793

-96.2 -97.1



S220 Offsets and Measurements - Summary

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 2.868 2.071 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 8.252 20.144 n/a -11.892 0.797 -7.028 1.866
z 4.752 17.821 0.081 13.068 -13.068 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220 7111 are derived from Westlake Survey Report NOAA Fairweather 09-23-03, Fairweather Centerline Survey (NGS) Report March 2009, and measurements by FA personnel in 2010 and 2011.
Calculations

Coordinate Westlake NGS Westlake NGS NGS Westlake
Systems IMU easting 0.000 Top of IMU x -11.892 IMU Base to baseline at Keel Phase Center         x -11.892 IMU Top (m) x 0.000 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
used Base northing 0.000 to Port Ant y 0.797 (ft) elevation 12.856 Port Ant y 0.797 y 0.000 (ft) easting -11.638 (ft) elevation 12.856
as listed (ft/m) elevation 0.000 (m) z 13.068 IMU Base to baseline at Keel (m) z 13.068 z 0.000 (m) easting -3.547 (m) elevation 3.919

(m) elevation 3.919
8111 (from IMU Base to sensor) CARIS Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU

easting 27.072 Port x 0.797 Waterline to Keel Top of old Stbd       x -11.886 Top of old Port           x -11.892 (m) easting -27.737 (m) elevation 0.168
(ft) northing 9.410 Ant y -11.892 (ft) elevation 13.67 Ant (pre-2010)        y 2.794 Ant (pre-2010)           y 0.797 Top of IMU to Keel

elevation 15.042 (m) z -13.068 Waterline to Keel (m) z 13.051 (m) z 13.047 IMU to Frame 0 (FP) (m) elevation 4.086
(m) elevation 4.167 (m) easting 24.190

8111 (from IMU Base to sensor) Westlake See Ship's Draft Spreadsheet Top to Base of Old (pre-2010) Ant Top to Base of Old (pre-2010) Ant Center of Gravity above baseline
easting 8.252 (m) easting 8.252 measured (in)     z 2.477 measured (in)        z 2.477 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

(m) northing 2.868 Top of IMU northing 2.868 Top of IMU to Base of IMU (m)     z 0.0629 (m)        z 0.0629 (ft) easting 102.42 Mean Metacentric height
elevation 4.585  to 8111 elevation 4.752 (m) elevation 0.168 (m) easting 31.218 (ft) elevation 3.88

Top of IMU to Keel
Base of IMU to Top of IMU CARIS (m) 4.086 Top of Stbd x -11.886 Top of Port x -11.892 IMU to Centerline Heave Pt* to baseline at Keel

(m) elevation -0.168 (m) x 2.868 Ant Post y 2.794 Ant Post y 0.797 (ft) northing 6.122 (ft) elevation 20.25
Top of IMU y 8.252 (m) z 12.988 (m) z 12.984 (m) northing 1.866 (m) elevation 6.172
 to 8111 z 4.752

2010 value -> Correction based on Ref Surface Base to Phase Ctr New(2010) Ant Base to Phase Ctr New(2010) Ant Heave Pt* to Centerline (*Heave Pt is Metacenter)
-0.322 (m) elevation 0 listed on Antm)        z 0.0843 listed on Ant (m)        z 0.0843 (m) northing 0 (FP is Forward Perpendicular)

Westlake easting 8.252 CARIS x 2.071 Westlake easting N/A NGS (m)     x -11.886 NGS (m)        x -11.892 Westlake easting -7.028
Top-IMU northing 2.868 y 20.144 Waterline northing N/A Top of IMU             y 2.794 Top of IMU y 0.797 Top-IMU to northing 1.866
to 8111 (m)elevation 4.752 (m) z 17.821 to IMU  (m) elevation 0.081 to Stbd Ant z 13.072  to Port Ant z 13.068 Heave Pt* (m elevation -2.086

(aka Stbd Ant Phase Center) (aka Port Ant Phase Center) (*see Description Tab)
Coord Sys. CARIS Coord Sys. CARIS Coord. Sys CARIS Coord Sys. POS/MV Coord. Sys. POS/MV

x 2.868 x 2.071 x N/A x -11.892 x -7.028
y 8.252 y 20.144 y N/A y 0.797 y 1.866
z 4.752 z 17.821 z 0.081 Scalar Distance (m) 1.997 z -13.068 z -2.086

Port Ant to Stbd Ant IMU to Port Ant

IMU to Heave

IMU to Port Ant

IMU to 7/8111

IMU to 7/8111 IMU to Port Ant

IMU to Heave

IMU to Heave

Measured Values

Port Ant to Stbd Ant

Port Ant to 7/8111 Waterline to RP*

Port Ant to 7/8111

IMU to 7/8111 (MRU to Trans) Port Ant to 7/8111 (Nav to Trans)

Waterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Stbd Antenna



S220 Offsets and Measurements - Summary

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.304 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 7.665 19.557 n/a -11.892 0.797 -7.028 1.866
z 4.726 17.794 0.081 13.068 -13.068 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220 8160 are derived from Westlake Survey Report NOAA Fairweather 09-23-03, Fairweather Centerline Survey (NGS) Report March 2009, and measurements by FA personnel.
Derivations
Coord. Sys.

Westlake NGS 2009
IMU easting 0.000 Top of IMU x -11.892
Base northing 0.000 to Port Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.068

8160 (from IMU Base to sensor) CARIS
easting 25.149 Port x 0.797

(ft) northing 1.619 Ant y -11.892
elevation 14.956 (m) z -13.068

8160 (from IMU Base to sensor) Westlake
easting 7.665 (m) easting 7.665

(m) northing 0.493 Top of IMU northing 0.493
elevation 4.559  to 8160 elevation 4.726

Base of IMU to Top of IMU CARIS
(m) elevation -0.168 (m) x 0.493

Top of IMU y 7.665
2010 value -> Correction based on Ref Surface  to 8160 z 4.726

-0.206 (m) elevation 0

Westlake easting 7.665 CARIS x -0.304
Top of IMU northing 0.493 y 19.557
to 8160 (m) elevation 4.726 (m) z 17.794

Coord Sys CARIS Coord Sys CARIS
x 0.493 x -0.304
y 7.665 y 19.557
z 4.726 z 17.794

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Port Ant to 8160

IMU to Port Ant



Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 7111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Scaler Distance 1.997

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.068

Port Antenna to 7111
x: 2.071
y: 20.144
z: 17.821

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.794

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.068

IMU to Tow Pt K5K
x: 1.866

y: -42.642
z: -7.402

IMU to Tow Pt K5K
x: 1.866

y: -42.642
z: -7.402

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.794

Port Antenna to 7111
x: 2.071
y: 20.144
z: 17.821

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 7111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000



x y z x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726 1.866 -42.642 -7.402

x y z x y z
2.071 20.144 17.821 -0.304 19.557 17.794

x y z
Scaler Distance 1.997 0.797 -11.892 13.068

x y z x y z From pg 3 of the Westlake Survey
n/a n/a 0.081 1.866 -7.028 -2.086

Relative positions obtained from 
Port Ant to 7/8111 via IMU.

Waterline to RP*

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s 
reference frame It is 4 087 m

IMU to Port Ant

IMU to Heave

This information comes from a combination of the Westlake, 
NGS surveys, and measurements by FA personnel. The NGS 
2009 survey was to the top of the antenna, that distance (z-
value) was measured in 2010 and subtracted to get the xyz of 
the antenna post.  Then the distance (z-value) up to the phase 
center to the new 2010 antanna was added to obtain the xyz of 
the phase center of the newly installed (May2010) antenna.

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition 
of the -0.168 m offset included for 
the height of the IMU.  

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 7111 
transducer are taken from the 
Westlake report along with the the -
0.168 m offset included for the 
height of the IMU.  

Port Ant to Stbd Ant

Using the NGS 2009 survey values 
for the antennas, a calculated 
vector for antenna separation was 
determined. The distance from Top 
of Antenna to Phase Center does 
not affect this calculation and 
therefore was not included.

IMU to Heave

IMU to 7/8111 (MRU to Trans)

Port Ant to 7/8111 (Nav to Trans)

IMU to TOW PT K5K

The offsets were determined using 
the NGS 2009 survey values for 
the A-Frame Stbd Pivot and 
measurements by FA personnel. 
Measurements between the A-
Frame Pivot and the Tow point 
were made with a steel tape and 
digital level to determine the 
deployed angle of the A-Frame. 

Relative positions obtained from 
Port Ant to 7/8111 via IMU.

IMU to Heave

measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on 
observations, Ship's Draft 
spreadsheet.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

reference frame.  It is 4.087 m 
(3.919 m to base line + 0.168 m 
for IMU height above base plate) 
above the keel, 1.866 m port of 
centerline and 3.547 m forward of 
frame 52.  This information is 
needed to reference the IMU to 
the ship’s Heave Measurement 
Location (Heave Point). *

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location 
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the 
height of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There 
may be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by 
the center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is 
at the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed 
to approximately 14.5 feet respectively.

is 1.866 m to port of the centerline.



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

The relocation of the POS M/V antenna forced a partial resurvey in Feb-2007 by Steven Breidenbach of NGS (values no longer utilized).

While in drydock, another NGS (Centerline) survey was conducted March, 2009. 

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and 
the IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from 
the IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for 
the POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the 
IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPU, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
El i M D ld f W l k d i f ll d b E il d i h f Th il i l d h d f hi

Offset values for the ship were derived from three sources.  Three static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  

Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Additionally, various reference points (bench marks) were re-established onboard the vessel to 
aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle, 
WA.  The weather conditions over the two days required to conduct this survey were windy, 
cool, with intermittent rain.   
 
 
INSTRUMENTATION 
 
The Leica TC2003 total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 0.2mm + 2ppm 
 
A Leica precision prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 
 
 
 



 
 
NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the Northing 
(Y) axis runs along the centerline of the ship and is positive from the IMU towards the bow of 
the ship.  The Easting (X) axis is perpendicular to the centerline of the ship and is positive from 
the IMU towards the right, when looking at the ship from the stern.  The Up (Z) axis is positive 
in an upward direction from the IMU.   
 
 
SURVEY METHODOLOGY 
 
02/15/2009 
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.  
A distance and height difference were measured between temporary control points 1 and 3.  
These values were used to determine the coordinates at temporary control point 3.  Temporary 
control points 1 and 3 were located along the top deck and on the north side of the dry dock 
vessel.   
 
Temporary control point 1 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control points 2 and 4(located on the top deck of the 
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were 
observed in both direct and reverse. 
 
Temporary control point 2 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control point W1 (located on the top deck of the dry 
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in 
both direct and reverse.  Temporary control point 1 was also observed and yielded an inverse 
check of 0.001m horizontally and 0.001m vertically. 
  
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 5 (located on the south side and on the top deck of the dry 
dock vessel) was observed in both direct and reverse.  
 
Temporary control point 5 was occupied and control point 4 was observed for a backsight.  After 
initialization, temporary control point D2 (located inside the ship on the D deck along the 
starboard side) was observed in both direct and reverse. 
 



Temporary control point H1 was occupied and control point 1 was observed for a backsight.  
After initialization, temporary control point H2 (located on the bottom deck of the dry dock 
vessel), and USBL BM were observed in both direct and reverse. 
 
Temporary control point H2 was occupied and temporary control point H1 was observed for a 
backsight.  After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.  
Temporary control point W1 was also observed and yielded an inverse check of 0.019m 
horizontally and 0.033m vertically. 
 
Temporary control point D1 was occupied and temporary control point D2 was observed for a 
backsight.  After initialization, temporary control point D3 (located in the doorway leading to the 
mess hall on the D deck) was observed in both direct and reverse.   
 
Temporary control point D3 was occupied and temporary control point D1 was observed for a 
backsight.  After initialization, temporary control point C1 (located on the C deck near the IMU) 
was observed in both direct and reverse.  Temporary control point D2 was also observed and 
yielded an inverse check of 0.026m horizontally and 0.0001m vertically. 
 
Temporary control point C1 was occupied and temporary control point D3 was observed for a 
backsight.  After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER, 
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct 
and reverse. 
 
02/16/2009 
 
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 6 (located on the south side and on the top deck of the dry 
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point 
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m 
vertically. 
 
Temporary control point 6 was occupied and temporary control point 4 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT 
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT 
PORT were observed in both direct and reverse. 
 
Temporary control point 3 was occupied and temporary control point 1 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS 
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse. 
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m 
horizontally and 0.001m vertically.  
 
The reference frame was rotated using STERN BM as the point of rotation.  A zero degree 
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was 
then translated to relocate the origin of the reference frame to the IMU. 
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INVERSE RESULTS 
 
Inverses were computed between the determined positions of those ship benchmarks and 
sensor points which were determined from two separate locations  The results of these inverses 
are: 
 
ID    Horizontal Dist.(m) Elevation Diff(m) 
BOW BM    0.0150    0.0240 
STERN BM    0.0060    0.0010 
POS GPS ANT STARBOARD  0.0100    0.0001 
POS GPS ANT PORT   0.0100    0.0000 
 
 
DISCUSSION 
 
The Fairweather was in dry dock during this survey, however, the dry dock vessel was still 
subject to movement due to wave action.   Conducting a survey such as this while the ship is 
moving requires that the automatic compensators in the survey instrument be turned off.  The 
survey is therefore conducted with all survey instrumentation set up relative to the mean 
movement of the related level vials.  While every effort was made to make the most precise 
measurements possible, some additional error accumulation cannot be avoided under these type 
observing conditions.   
 
The POS GPS antenna coordinates were determined to the top center of the antennas.  The Z 
value should be corrected to the Antenna Reference Point (ARP).  In order to apply this 
correction, the mechanical height of the antenna should be determined and subtracted from the Z 
value determined during this survey for both of the POS GPS antennas. 
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Coordinate Listing using IMU as the Reference Frame Origin  
 
 

ID  X(NORTHING)m Y(EASTING)m  Z(UP)m 

IMU CENTER  0.000 0.000 0.000 
IMU STERN PORT CORNER  ‐0.071 ‐0.089 ‐0.001 
IMU BOW PORT CORNER  0.070 ‐0.086 ‐0.001 
IMU BOW STARBOARD CORNER  0.069 0.087 0.000 
IMU STERN STARBOARD CORNER  ‐0.073 0.086 0.000 
BOW BM  28.378 1.805 7.796 
STERN BM  ‐40.306 1.805 2.255 
USBL BM  ‐28.354 1.738 ‐4.204 
8160 BM  8.407 0.395 ‐4.400 
8111 BM  8.532 3.002 ‐4.666 
POS GPS ANT RAIL BM  ‐12.011 1.785 10.381 
POS IMU ANT DECK BM  ‐11.790 1.780 9.305 
POS GPS ANT STARBOARD  ‐11.886 2.794 13.051 
POS GPS ANT PORT  ‐11.892 0.797 13.047 
TRANSOM PIVOT POINT STARBOARD  ‐39.727 3.366 2.385 
TRANSOM PIVOT POINT PORT  ‐39.722 0.240 2.345 
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IMU Reference Points 
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POS GPS ANTENNAS 
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BOW CENTERLINE REFERENCE POINT 
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CENTERLINE REFERENCE POINT ON G DECK 
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CENTERLINE REFERENCE POINT ON RAIL AT G DECK 
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CENTERLINE STERN REFERENCE POINT 
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TRANSOM REFERENCE POINT ON PORT SIDE 

 

 
TRANSOM REFERENCE POINT ON STARBOARD SIDE 
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8111 REFERENCE POINT 
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8160 REFERENCE POINT 
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Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Westlake Consultants, Inc.
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Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation
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Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

9/11/2013
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

9/11/2013
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

2120 79.28m
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

038/01/13 N 123/28/03 W2013_254_212053.HEX

S220 7111

Froelich

254

2013_254_S220.004-007

Cordell 

Sand and rocks

calmCordell Bank, CA

100-30 m

254

POSMV Filename(s)

Applanix POS/MV   S/N:3628    IMU S/N:XXX



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1
2
3
4
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 092 6.0
2 271 6.0
3 092 8.0
4 270 8.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 092 6.0
2 270 6.0
3 270 8.0
4 2013M_2542037.RAW 090 8.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 060 4.0
2 225 4.0
3
4
5
6
7
8

2013M_25411945.RAW
2013M_25411956.RAW

2013M_25411931.RAW

XTF Line Filename
2013M_2541917.RAW

2013M_2541906.RAW
2013M_2541854.RAW

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2013M_2542026.RAW

2013M_2542012.RAW
XTF Line Filename

2013M_2542050.RAW

XTF Line Filename



Processing Log
9/11/2013
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1917&1945 0.07 1945&1956 -0.53 1854&1906 -0.14 2026&2037 -0.47
1917&1945 0.00 1917&1931 -0.40 1854&1906 -0.17 2012&2050 -0.40
1931&1956 0.00 1945&1956 -0.38 1854&1907 -0.13 2026&2037 -0.32
1917&1945 0.00 1917&1931 -0.44 1854&1906 -0.13 2026&2037 -0.38
1917&1945 0.00 1917&1931 -0.43 1854&1906 -0.14 2026&2037 -0.40

0.01 -0.44 -0.14 -0.39
0.03 0.06 0.02 0.05
0.01 -0.44 -0.14 -0.39

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.04 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 9/13/2013Tami Beduhn

2013_254_S220.000-2013_254_S220.007

zero tide

NIDW3hr

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Faulkes
Froelich

254

Wartick
Beduhn
Smith

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Faulkes

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Fairweather Vessel: S220
Date: 8/6/2013 Dn: 218
Personnel: LT Ryan Wartick, HSST Douglas Bravo

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 48 49 7.55

Lon 125 30 0.12

DGPS B St ti DGPS R i S i l#

POSMV filename(s)

3628

Whidb I l d WA 0324 11969 0002

5044K18796

129.100.1.231

4904K34026

292

NOAA POS/MV Calibration Report

Offshore Washington

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302 kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

Secondary GPS

N

Whidbey Island, WA 0324-11969-0002



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 0103

End time: 0203

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

NoneNone

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None



COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



$UTC, 19200, N,8,1, NULL
1 Hz

Crossover
Patch

Serial

2808 Acq

DGPS Reciever

9600, N,8,1, NULL
RTCM 104DIFF

Key

129.100.1.230

129.100.1.231
POSPAC Groups

25 Hz

129.100.2.230

C
O

M
2

COM2

9600, N,8,1, NULL
Reson Controller

COM1

38400, N
,8,1, N

U
LL

25 H
z TS

S
1

COM2
POS MV 320

SBE 19plus CTD

9600, N,8,1, NULL

C
O

M
1

9 Sep 2013

Launch 2808- 8125 Wiring 
CST BeduhnRev 5.0

Reson 8125
COM1

COM3
129.100.2.235

UDP 1028

AIS
38400, N, 8, 1

C
O

M
10

Digibar
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Appendix III 
 
 
Total Propagated Uncertainty (TPU) 
 
Fairweather TPU Values 
 
 



PROJECT
Tide Measurement (m)

(Use in CARIS)
Tide Zoning 95%

Provided by CO‐OPS)
Tide Zoning (m) ‐ 1 sigma 

(Use in CARIS)
SYSTEM

SV Measured (m/s)
(Use in CARIS)

SV Surface (m/s)
(Use in CARIS)

DEFAULT 0.01 0.2 0.10 7125 2 0.5
non‐TCARI 7111/8160 1 0.5

DEFAULT 0 0 0.00 7125 2 0.5
TCARI 7111/8160 1 0.5

OPR‐N395‐FA‐13 0 0 0.097 7125 2 0.5
Central Puget Sound VDATUM 7111/8160 1 0.5

OPR‐L318‐FA‐13 0.01 0.15 0.08 2 0.5
Approaches LA Long 

Beach CA 2 0.5

Tides
Measured: 

Sound Speed
Measured:  Range (0.5m/s to 4 m/s) dependent on spatial and temporal variability

Use 1 m/s for casts every 15 min or less
Use 4 m/s for casts every 4 hours

Surface: Range (0.2 m/s to 2 m/s): dependent on surface sound speed gradient

TCARI automatically calculates the error associated with water level interpolation. This error is incorporated into the residual/harmonic solutions 
and included in the Total Propagated Error(TPE) for the survey.

Zoning (TCARI):

Tide zoning uncertainty values at the 95% confidence level for discrete zoning are provided by CO‐OPS in the tide requirements document on the project CD. All error value 
components entered in CARIS for TPE calculation are assumed to be 1 sigma; therefore, the value provided by CO‐OPS should be divided by 1.96.

TIDE and SOUND SPEED ‐ COMPUTE TPE VALUES

Range (0.01m ‐ 0.40m) dependent on distance from gauge, range of tide, rate of tide change, and meteorological factors. Value 
provided by CO‐OPS in the tide document in the project instructions package. 

Zoning (discrete): 
Range (0.01m ‐ 0.05m) dependent on gauge accuracy and duration of deployment



Appendix IV 
 
 
Additional Correspondence 
 
None 
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